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Chapter 1 • Introduction 

PowerNet Products Overview 
PowerNet products by Connect are devoted exclusively to making wireless networks as 
useful, efficient, and reliable as possible. PowerNet routes data from any portable RF 
terminal to any host computer quickly and efficiently. 

PowerNet supports: 
• = All of the most popular 2.4 GHz and 900 MHz wireless systems 
• = All major network media, including Ethernet and Serial 
• = All major transport protocols, such as TCP/IP  
• = All common legacy terminal emulators, including VT100, VT220, 3270, and 5250  
• = Multiple dissimilar hosts, using your existing applications and networks 
• = Multiple RF LANs, allowing a single controller to support multiple locations, 

covering such large areas as airport terminals and distribution centers. 
• = Multiple portable terminal models (with more being added every day). 

The PowerNet family of products works with almost all architectures, providing users 
the ability to change host computers and options as network requirements grow. 
• = OpenAir Linux – runs on Linux  
• = OpenAir Windows – runs on Windows  
• = PowerNet Twin Client - software for virtually all makes and models of wireless data 

collection terminals. Supports all common terminal emulations and client/server 
applications 

PowerNet OpenAir provides the user with a fully-integrated hardware platform with 
either OpenAir Linux or OpenAir Windows software already integrated and installed, 
ready to plug in and use. 

PowerNet AirLinc provides the user with the ability to develop complete wireless data 
collection applications that operate with any ODBC compliant database. 
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PowerNet Twin Client Overview  
PowerNet Twin Client provides VT100, VT220, HP700/92, TN3270 (Telnet 3270), and 
TN5250 (Telnet 5250) terminal emulations directly from an RF terminal to any TCP/IP 
telnet-capable host application.  Network controllers or servers are not necessary; the 
Windows-based Twin Client configuration utility is used to load the client software onto 
the RF terminal from a PC.  

Twin Client, based on Connect’s PowerNet server-based emulation software, contains 
much of that package’s functionality and features. Additionally, users may change and 
expand the default configuration options that Twin Client downloads to the RF 
terminals, increasing their data-gathering capabilities. 

PowerNet Twin Client Modes of Operation 
PowerNet Twin Client can be used in two modes of operation: thick client or thin client.  
• = Thick client mode (sometimes referred to as Telnet Client mode) provides a Telnet 

connection to a Telnet-capable host computer.  Terminals running in thick client 
mode become a network of RF devices that provide all the PowerNet features and 
command capabilities (except some file storage and printing) locally on the RF 
devices.  

• = Thin client mode uses a proprietary communications protocol to communicate 
directly with a PowerNet Server.  RF terminals operating in thin client mode rely on 
most of the functionality of the system being located on the PowerNet Server, rather 
than on the RF devices. 

PowerNet Twin Client Features 
PowerNet Twin Client offers these benefits:  
• = Centralized control of terminal functionality - PowerNet Twin Client allows system 

administrators full control and support of remote RF devices from one system. 
Administrators can have full control of system tuning, functionality, and presentation 
parameters used in supporting remote RF devices. 

• = Terminal Screen Design - Windows-based configuration and formatting utility that 
enables terminal screen design and configuration. 

• = Diagnostics/Logs -You can set logging to report different levels and types of 
information and to report at variable time intervals. Logging generates reports as the 
system runs so diagnosis can begin soon after receiving a problem report. 

• = Built in migration path to other PowerNet products. 
• = Full purchase credit towards an upgrade to a PowerNet Server license 
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PowerNet User Interface Structure 
The PowerNet Twin Client program opening screen contains all the features you will use 
to establish connections, configure your RF devices, and download programs. 

Opening Screen 
From Windows, with your mouse, select Start, Programs, PowerNet, and Twin Client 
Manager. The PowerNet Twin Client Configuration Utility screen appears. This is Twin 
Client’s main screen; all functions are accessed from its menus and tabs. 

 

Menus 
The opening screen components discussed in this manual, File, Terminal, Object 
Editors, Setting, View, and Help are the options available from the Menu Bar. These 
functions set up and maintain the RF terminal(s) and provide system management.  

Toolbar 
Under the menu bar, the tool bar provides quick access to functions. The toolbar can be 
turned on or off by changing the Toolbar parameter found on the View menu. 
Positioning the mouse cursor over the toolbar icon displays a brief description of the 
tool’s function. If the status line is enabled, a more detailed description of the tool is 
displayed on the status line as well. The toolbar can be relocated on the screen by 
clicking and dragging the toolbar box around the screen.  

The application-specific functions available on the toolbar are as follows: 
 

 
Exit Exits the configuration utility. 

 New File Opens a new file. 

 Open File Displays a list of files that may be opened. 

 
Save/Save as Saves the file, or if unnamed, prompts for a name and 

saves. 

 
Download Downloads configuration files from the PC to the RF 

terminal. 

 
Upload Uploads files from the RF terminal to the PC. 

 
About Displays the About Configuration Utility... box. 
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Configuration Tabs 
Each configuration tab may be adjusted to set various parameters through either a drop-
down selection box, a check box (setting the option active when checked), or through 
entering data into a text entry field. The functions available by using these configuration 
tabs are explained throughout this manual. 

Status Bar 
The status bar, located at the bottom of the screen, provides the current Terminal 
Emulation status within the menu bar. The status line can be turned on or off through the 
status selection of the View item on the menu bar. 

Forms 
Many Twin Client screens require entry into forms, which are useful for collecting 
information. Fields appear on forms in which you must select from various fixed choices 
or enter other information from the keyboard. Conventional Windows selections indicate 
whether a field is available from a pulldown, a selection box, a radio button, or requires 
specific keyboard input. This input may be a new field name or the address of a specific 
network component for which statistics are displayed. 

Logs 
System logs are dynamic and use their own format. The information, which is constantly 
being written to a log file, can be of use for system administrators who are trying to 
debug problems. Procedures for setting log levels can be found in Chapter 3. 

In This Manual 
This manual addresses the following tasks: 
• = Chapter one provides an overview of PowerNet Twin Client’s capabilities and 

structure and explains what information you can find in this manual. 
• = Chapter two shows how to load Twin Client program and setup files onto your PC 

and onto your RF terminals. It explains the Configuration Utility, the backbone of 
Twin Client, and gives instructions for the basic setup of your RF terminals. 

• = Chapter three discusses adding capabilities to the basic RF terminal setup by 
modifying a configuration or creating a new, or special-purpose configuration. 

• = Chapter four gives advanced configuration options and VTerm extended commands. 
This material allows further fine-tuning of your terminal environment. 

• = Chapter 5 provides New Environ Telnet Extension details, such as creating named 
variables, creating common settings, creating terminal specific settings, changing and 
deleting settings, saving new environ settings, TN3270 negotiation, and new environ 
negotiation. 

• = Chapter 6 discusses options in the display formatter, such as setting the emulation, 
starting the emulator, taking snapshots, and formatting. 
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• = Chapter 7 contains information on printing under 3270 and 5250 emulation. 

Keys and Buttons 
Certain keys move the cursor on a menu or form. The left mouse button is used for point 
and click functions, and the right mouse button gives submenus to certain selections such 
as Menu, User, Screen, and Procedures selections from the Project Manager Screen. 
 
Key/Button Function 

<↑↑↑↑> The up arrow moves the cursor backward one field position in a form. 

<↓↓↓↓> The down arrow moves the cursor forward one field position in a form. 

Bksp When the Bksp key is used in fields within a form, it moves the cursor backward 
one character space, deleting the character. 

Del When the Del key is used in fields within a form, it moves the cursor forward 
one character space, deleting the character. 

Tab The Tab key moves between fields on a form screen. 
 

Related Documents 
Each supported terminal has a Supported Equipment Manual containing information 
specific to that manufacturer’s terminal at http://www.connectrf.com/ster.htm. 

http://www.connectrf.com/ster.htm
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Chapter 2 • System Installation/Setup 
This chapter describes the necessary steps for installing PowerNet Twin Client software, 
helps you prepare your terminals, and gets you started with running Twin Client.  

Minimum Installation Requirements 
Installation of PowerNet Twin Client requires that the PC have basic hardware and 
software requirements installed on it: 
• = A Pentium level PC or Server  
• = 32 MB of RAM 
• = 10 MB of free hard disk space available 
• = Microsoft Windows 95, 98, ME, XP, or NT/2000 installed on the PC as an operating 

system 

Installing PowerNet Twin Client for Windows 
1. Download the PowerNet Twin Client software package from the Connect web site at 

http://www.connectrf.com. Click on Partner Services and then on Software 
Downloads. 

2. The downloaded file is a compressed archive. After extraction using a utility such as 
WinZip or PKWARE, folders are created on the hard disk. Click on the Disk1 folder 
to view the files. Click on the Setup application. 

3. Click on OK to begin the installation process. The installation program runs an 
installation wizard and then presents the Setup screen.  

Note: Throughout the installation, click on the Next button to continue, or click on the 
Cancel button to exit the installation process. 

4. Enter your Installation Key (identification number) when asked for it. (Your 
installation key is found online at http://www.connectrf.com.) 

5. You are prompted for a target folder (default is c:\PowerNet\TwinClient). If you 
choose to change the default folder, click on Browse.  

6. You are prompted for the name of a program group (folder) to install the PowerNet 
software into. The default group is PowerNet. You may change this default either by 
selecting an existing program group or by typing in a new name at the prompt.  

7. The PowerNet installation program begins copying the files to the target folders.  

http://www.connectrf.com/
http://www.connectrf.com/
http://www.connectrf.com/
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8. When the installation program is complete, you must reboot the system to initialize 
the PowerNet software. (The system must be restarted in order for the PowerNet 
software to function correctly.) 

a. To reboot the system immediately, select Finish.  

b. To reboot the PowerNet server software later, select the Restart Later option, 
and click on Finish.  

These steps complete the PowerNet Twin Client software installation process on your 
computer.   

Preparing Terminals for PowerNet Twin Client 
Once the installation process on your PC is complete, the next step is to prepare the 
handheld RF terminal(s) for software installation. The Configuration Utility transfers 
program and configuration files to the RF terminal(s) over a serial communications link, 
and configures them with the PowerNet Twin Client parameters.  

Note: The following instructions are necessarily generic.  

Selecting Terminal Types 
1. Connect the appropriate serial cable from a serial port on the PC to the 

communications port of the terminal or cradle (docking station) before turning power 
on to the computer. 

2. Start the Configuration Utility by clicking Windows Start, Programs, PowerNet, 
and Twin Client Manager (or click on the PowerNet Twin Client icon). The 
PowerNet TN Configuration Utility screen appears. 

 
 

3. Select Settings, then Options. The PowerNet Terminal Loader screen appears. 
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4. Select from the lists, the correct Manufacturer, Terminal Model, and Radio Type for 

your RF terminal(s). 

5. Select the COM port your PC uses for the communications cable. Click OK. 

6. Select Settings, and then Emulations. The Emulation screen appears. 

 
7. Choose the correct emulation for your terminal(s) and click OK. 

8. Select File, and then Save As. Type the name default and click Save. The file is 
saved as default.cf. 

Setting the Host’s IP Address 
The Servers are the Telnet host systems the terminals will access. 
 

 

To set these addresses, from the Settings menu, click on Servers. 
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Click on Add.  

 

The Terminal Type scroll box is used to override the existing emulation type. 

To do a DNS lookup, enter the name of the server, and click on the Lookup button. 
 
Note: The DNS server must be running on the PC for this to work.   

To set these addresses from the Settings menu, click on Servers and then click on Add. 
Enter the name of each server, its IP Address and IP port (normally 23 for Telnet 
servers), and emulation type. Then click on OK. 
Repeat this step for each telnet server the terminals are required to access. If an error is 
made in the name, IP Address, IP Port number, or Terminal emulation type, click on the 
line that is in error and then click on the Edit button to make the corrections.  

Use the Load button if you want to load an .svr file. Use the Save As button if you want 
to save your file as an .svr file. 

You are now ready to download the program and configuration files to the terminal. 
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Sending Program and Setup Files to the Terminal(s) 
1. Turn on the power to your RF terminal or cradle and verify that a DOS prompt (C:\) 

appears in the terminal window. 

2. On your PC, select Terminal, and then Send Program Files to Terminal. A message 
appears asking if you would like to also send setup files. 

3. Click Yes. The program and configuration files are sent to the RF device. You will 
receive a Transfer Complete message when the transfer is successful. 

Note: For more detailed instructions on a specific terminal, refer to its Supported 
Equipment Manual at http://www.connectrf.com/ster.htm. 

Note: For keypad configuration information on a specific terminal, refer also to its 
Supported Equipment Manual at http://www.connectrf.com/ster.htm. 

Terminal Setup Using Twin Client Menus 
The Twin Client menu system is accessed by pressing uppercase C at the Twin Client 
main menu shown below. 
 

Twin Client 
© 1991-2003, Connect, Inc. 
 
Keypress to Continue

To make a menu selection, use the Up-Arrow and Down-Arrow keys to navigate the 
menu, and press Enter to select the highlighted option. 

Below are descriptions of possible menu options.  

Edit Mobile Unit IP  
The IP list contains the terminal IP address, the Subnet Mask and the Router IP address. 
Enter the appropriate address. Select <F3> to save and/or <F7> to Quit, as shown below.  
 

IP  206.232.71.38 
SN  255.255.255.0 
RT  206.232.71.1 

<F3> Save  <F7> Quit  

Edit Server/Host IPs 
If you wish to change the host IP address or addresses using the terminal menus, select 
this option and enter up to four Host IP addresses as required. 
 

http://www.connectrf.com/ster.htm
http://www.connectrf.com/ster.htm
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     Host 0 
IP 206.183.67.155 
Port 23__ 
 
<F3> Save <F7> Quit

 
Press F3 to save the configurations. 

Edit Radio Option 
This function acts as a password to join the radio network.  Terminals associating with 
an Access Point must supply a matching value, determined by their configurations, or 
their association requests will be ignored. 
 
ID  tsunami____________ 

<F3> Save    <F7> Quit  

Edit License Key/Authorization 
This menu option permits authorization of each terminal manually. Select this option to 
obtain the terminal's Identification Code, which is then used to obtain the Authorization 
code from the Connect web site. 

The 12-digit value displayed at the top of the terminal screen is the Identification Code 
for the terminal. 
 

00A0F826E614 
Authorization    ______________ 
not authorized 
 
<F3> Save <F7> Quit

Type the authorization code into the field as it appears on the WEB site. Punctuation 
characters, such as the hyphen (-), are required. Press F3 to save the authorization code. 

Run Site Survey 
This option (a feature of Spectrum 1) is applicable to Release 5.0 and may be obsolete 
for your terminal. 

Switch Client Modes 
The Twin Client normally operates in Telnet mode, which provides direct connection to 
Telnet hosts. It can also operate in Server mode, through an OpenAir server. Select this 
menu option to switch between Server and Telnet modes of operation.  

Set Contrast 
Adjust the contrast as required by pressing the right and left arrow keys. 
The Contrast screen appears as follows. 
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CONTRAST 

F3> Save  <F7>Quit 

Run Client Emulator 
 
After all desired changes have been made, select this option to return to the Twin Client 
main menu. Then press any key to establish the Telnet session and begin emulation. 
 
Note: For information on terminal setup for a specific terminal, refer to its Supported 

Equipment Manual at http://www.connectrf.com/ster.htm. 

Authorizing PowerNet 
 

Each PowerNet Twin Client will run for 30 minutes at a time without authorization.  
Uninterrupted operation for a production environment is the result of authorizing the 
software.  

The Twin Client Manager can automatically authorize the terminal over the wireless 
network if the following requirements are met: 
• = A PC running Twin Client Manager is connected to the wire LAN segment with at 

least one access point within range of the terminal. 
• = The System ID of the PC on which Twin Client Manager is installed has been used 

to obtain a site license Authorization code from the Connect web site. 

To obtain the System ID of the Twin Client Manager, click on the Authorization option 
in the Tools menu, as shown below. 
 

 

The Authorization window is displayed as shown below. 
 

http://www.connectrf.com/ster.htm
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Your System ID appears in the first box of the screen.  

 
Go to http://www.connectrf.com. Click on Partner Services. Click on the Generate 
Authorization icon at the top of the page. Follow the directions on the web site. 

Authorized Terminals 
The number of terminals authorized, the number of terminals in use, and the number of 
terminals remaining is provided in the Authorized Terminals box on the lower left side 
of the screen. 

Click on the Details button to number the options in the screen below in the order of 
your priority. 

Note: The terminal may or may not be able to utilize the Formatter feature depending on 
its authorization codes. 

http://www.connectrf.com/
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Click on an option and move it using the Up and Down buttons.  

Click on OK when finished. 

The Manual Authorization button is an alternate method of obtaining an authorization 
code for a terminal. This method does not utilize Airloader, as does the other method. 

Click on this button, manually enter your mac address in the screen that appears, and 
click on OK. This enables you to generate individual authorization codes.  
 

Add Licenses 
The Add Licenses feature is used when adding additional licenses to an already site 
licensed Twin Client manager.  

An example of this is the instance in which Twin Client manager is licensed for 10 
licenses, and the customer purchases another 10 licenses to make a total of 20 licenses. 

From Twin Client manager, choose Authorization from under the Tools menu.  

Click on the Add Licenses button. 
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A pop-up box appears with the machine ID and a space for the additional licenses 
authorization code.   

 

Enter the additional license’s authorization code and click on OK. 

Use the machine ID in the pop-up box instead of the original machine ID to get your 
authorization code.   

If adding users, click on the Add Licenses button before generating the authorization 
code to get the most current machine ID. 
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Transfer Authorization 
 
The Transfer Authorization feature is used when moving a site license from one PC to 
another.   
 
After Twin Client manager is installed on a new PC, you will need the system/machine 
ID for it.  This ID appears in the first box of the authorization screen. 
 
From Twin Client manager, select Authorization from under the Tools menu. 

 
Click on the Transfer Authorization button on the old PC.  
 
You will be asked for the new system ID.  Enter this new system ID.  It will generate an 
authorization code for the new PC's Twin Client manager.  

 

 
 
 

Note: This feature only works if there are licenses remaining on the old PC.   
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Listing 
Click on the Listing button to view authorization codes issued.  

The authorization codes used along with their corresponding serial numbers will appear. 

 
 
Click on OK when finished. 

Click on the Close button when finished. 
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Chapter 3 • Configuring Options 

Overview of Configuring 
Changing Settings: The PowerNet Configuration Utility allows you to change 
keyboard, display, scanner and other settings on your RF devices. By changing these 
settings, your terminal(s) are reconfigured to work optimally with different host 
applications and with specific data collection (scanning) situations.  

Saving New Settings: You begin configuration by selecting and adjusting the settings 
that you want changed, then saving the new settings to a new configuration file. Once it 
is tested, this file can then be used for programming other terminals with the same 
settings. Using a configuration file allows you to quickly load multiple terminals, making 
a large, uniformly configured installation. 

Advanced Options: Advanced configuring covers optional, significantly involved 
choices and commands.  You will need to master the basic configuration techniques in 
this chapter before successfully learning and using advanced configuring. 

Using Configuration Tabs 
Each configuration tab on the PowerNet Twin Client Configuration Utility screen has 
options that may be adjusted to set various parameters.  

 

To select a tab, position the mouse over the desired tab, and click the left mouse button. 
Once the tab is selected, the various configuration parameters for the option are 
displayed for your use: drop-down selection boxes, check boxes, and text entry boxes. 

You may also select parameter options from the keyboard: 
• = Press the Tab key to navigate through the available fields. Each field is highlighted 

when selected.  
• = Press the up and down arrow keys when in a drop down selection box and scroll 

through the list of available options.  
• = Press the space bar, if at a check box, to toggle the option on or off.  
• = Type data directly with the keyboard into text fields. 
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Saving and Reusing a Configuration 
After you have adjusted the settings to a configuration you want, save the configuration 
with a meaningful name so you will recognize it when you want to use it. 

1. Select Save As from the File menu. 

2. Type a name for your configuration. 

3. Click Save. Your file is saved as a configuration (.cf) file. 

When you want to use the file to program additional RF terminals with the same 
configuration, open the file you have just saved: 

1. Select Open from the File menu. 

2. Select the name of the configuration you saved. 

3. Click Open. Apply the configuration to additional terminals. 

The following subsections describe each component of the Configuration Utility, its 
available values, and information about its use. 

Configuring with the Keyboard Tab 
Keyboard shows options that you can adjust to determine how your RF terminal 
keyboards perform when interacting with the host application.  
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End Key 

You can select a key on your RF terminal to signal the end of both the host connection 
and the RF session. The default is PF10. 

Auto Send Key  
Using this option enables you to define a keystroke to be sent automatically when an 
input field on the terminal is filled with keyed input. That is, if a field is set for 9 
characters, and 9 characters are entered into the field, the auto send key is automatically 
transmitted with the 9 characters move from the terminal.  The default is stat, which 
indicates that no keystroke is automatically generated. 

Note: Selecting the Length Check option on the Scanner disables the Auto Send Key. 

Key Click  
Checking this box gives you an audio simulation of key clicks from your terminal’s 
keyboard. Default is on (checked). 

Case Conversion  
Use this option if your application requires all upper or all lower case letters. Selecting 
the required case, upper or lower, converts all alphabetic characters sent from the 
terminal to that case. Select none, if your application does not require case conversion. 
Default is none; no conversion takes place.  

Caution: Applications may or may not be case-sensitive. Arbitrary case conversion 
without understanding your application’s use of cases may cause problems. 

Mapping Object  
This feature of PowerNet Twin Client allows you to map the numeric keys to a specified 
host terminal key for ease of use. For example, you can specify that pressing the key 2 on 
the terminal will send a PF24 key stroke to the host application. Refer to the Keyboard 
Mapping section in chapter 4, “Advanced Options” for more information on the content 
and format of this feature.  

Macro Object (VT/HP Only) 
A macro is a sequence of keystrokes resulting from pressing a single key. You can create 
a sequence that will be repeated every time you press a certain key on your RF terminal. 
Refer to the Keyboard Macros section in Advanced Configuring Options for more 
information on the content and format of this feature. 

Mode (VT/HP Only) 

This scrolling list selection controls the transmission characteristics of the VT/HP 
emulations. In char mode, each keystroke generates an individual transmission. In block 
mode, a transmission takes place only after a control key, such as Enter or a PF key, is 
depressed. The block mode is more efficient.  

Note: When set to char mode, the Collection timer value in the Timers tab should be set 
to between 30 and 50 milliseconds for maximum performance. 
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Auto EOF (3270,5250 only) 
Check this option if you want to automatically clear a field of existing data before any 
new data is entered into the field. In the event the terminal does not transmit any data for 
the input field (as happens when only the Tab key is pressed), no action is taken. 

Clear First (3270,5250 only) 
Check this option if you want the current input field cleared before beginning entry into 
the next field. 

Advanced (3270 only) 
Clicking the Advanced button on the Keyboard tab brings up the Advanced 3270 
Keyboard screen. Refer to Advanced 3270 Keyboard in Advanced Configuring Options 
for more information on the content and format of this feature. 

Configuring Screens with the Display Tab 
The Display screen shows options that you can adjust to determine how your RF 
terminal screens perform when interacting with the host application. The use of the 
Display Objects (Mapping, Dialog, and Formatter) are discussed in chapter 4, 
“Advanced Options”. 
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Quadrant Mode  

You can select a portion of the host screen to display on your terminal screen. The 
amount of the host screen shown is based on the RF terminal’s screen size. The value 
you select dictates how the terminal screen shows a portion of the host session screen. 
• = Off disables quadrant processing, so the software attempts to center the current host 

input field in the terminal display.  
• = On enables quadrant processing. However, input fields that cross quadrant 

boundaries result in a shift to the left or right.  
• = Soft always positions on a quadrant boundary regardless of input field boundaries. 

Viewing keys on the terminal are enabled so you can shift the terminal screen.  
• = Hard is the same as Soft except the viewing keys are disabled.  
• = Lock locks the terminal display to specific row and column (x ,y) coordinates on the 

host display. If you choose this option, you must then specify the coordinates in the 
following two boxes. 

Lock Row defines the Y coordinate for display position locking. Range is zero 
(0) to maximum number of rows on the host screen. Default is zero.  

Lock Column defines the X coordinate for display position locking. Range is 
zero (0) to the maximum number of columns on the host screen. Default is zero.  

Scroll Mode  

Scroll Mode defines the scrolling method used when you are using the terminal’s 
viewing keys.  
• = Half scrolls the terminal display in half-screen increments. For example, given a 16-

column screen, the screen is scrolled left and right 8 columns at a time. 
• = Full scrolls the terminal display in full screen increments. For example, given a 16-

column screen, the screen is scrolled left and right 16 columns at a time. 

Language 

You can choose the language for system message displays. 

Cursor Appearance 

All handheld terminals can show several cursor types. You can set their appearance to 
one of the following: 
Soft – Underscore (_) 
Hard – Block     � 
Hide – Nothing 

Mapping Object 

This feature is used to modify the displayed character set, and is an advanced integration 
option. 
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Dialog Object 

This feature is used to build session automation scripts, and is an advanced integration 
option. 

Formatting 
This feature is used to re-format the host display onto the terminal display, and is an 
advanced integration option. 

Relocation Group 

You can select a row or group of rows of the host screen and relocate them on the 
terminal screen automatically. For example, consider a terminal with 12 rows and a host 
application of 24 rows, where application error messages always appear in the 24th row, 
but the majority of the normal application information is in the first 12 rows. In this case, 
it is advantageous to relocate the 24th host display row to the 12th row, so that the 
terminal operator can see the error messages without having to scroll down to the bottom 
of the host display screen. 

Source  

Defines the starting row (zero-based) in the host display that is relocated to the 
destination row of the host display. Default is zero (0). 

Destination  

Defines the starting source row location (zero-based) in the host display. Default is zero 
(0). 

Row Count 

Specifies the number of host display rows to be relocated, starting with the row defined 
by the Source option and continuing from top to bottom of the display. The default, zero 
(0), disables row relocation. 

Move Blank  

You can choose to display null or space characters (blank data) from the host display 
onto your RF terminal screen by putting a check mark in this box. 

Reverse Video 

If the terminal manufacturer allows display specific features, Reverse Video allows you 
to display a reverse video on the terminal display. Default is on, checked. 

Wait Message 

Checking this box enables you to display the message: waiting for data on the terminal. 
The wait message generally appears when data is unavailable, and your terminal’s telnet 
session is waiting for it to become available. 
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Default Data (for 3270 and 5250 only) 

If you check this field, the contents of the input field in the command are transmitted to 
the terminal software. In this way, you can edit the data, then have the entire contents of 
the input field sent out by the terminal back to the server if anything other than a control 
key (such as Enter, Tab, or a function key) is pressed. If you leave this field unchecked, 
the field appears as underscores, regardless of what the host is supplying. 

Double High and Double Wide/Bold Size and Bold Font 

The double high and double wide check boxes enable (checked), or disable (unchecked), 
the display of characters on the DOS terminal screen in double high and double wide 
fonts, respectively. On a CE terminal, the double high and double wide check boxes are 
replaced with a font size scrolling list box and a bold font check box. The font size scroll 
box provides a choice of font size for the display of characters. The bold font check box 
enables (checked) or disables (unchecked) the display of characters in bold font. 

Formatter Object 

This feature is used to reformat the host display onto the terminal display. This is an 
advanced integration option. 

Alt Scan Key 

This scrolling list option within the formatter defines the control key automatically 
transmitted with scanned data. The list of keys depends on the type of emulation in use. 
The noop key indicates that no automatic control key will be sent. 

Advanced Key (VT/HP only) 

This is the key that will be sent automatically for the formatter feature when using VT 
emulation to skip unformatted fields. Set this key to whatever is required by the 
application to move from field to field. This will allow you to skip unneeded fields and 
the formatter will automatically bypass them. This is not required for 3270 or 5250 
emulation as there is a standard method for moving between fields. 
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Configuring with the Scanner Tab 
The Scanner tab gives you the capability of determining how the RF terminal scanner 
performs when it interacts with the host application.  

 

Send Key 
Using this key allows you to set up an automatic transmission of data once the field is 
filled. For instance, if you are scanning inventory, after each swipe that scans in a 
product code, the send key becomes active and causes the product code to be sent 
automatically. You can choose among Enter and 24 PF keys and others (this is the value 
that is added to the end of the actual scanned data to indicate the end of a field…) 

Scan Ahead 
This scrolling list option defines the number of scans that can be transmitted by the 
terminal without a response from the host system. The maximum is 24. 

Set to 0, scan ahead is disabled and you cannot scan again until the host response has 
been received. 
Set to 1, there is no scan ahead limit. 
Set to 2 and above, and the software will let you scan that many times until a host 
response is received. So if you set it to 3, it will allow you to scan only 2 more times 
before the host responds to the first scan. 
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You can choose to have workers not slowed down by high traffic by storing scanned data 
in the RF terminal’s buffer until it can be processed by the network. To be sure that the 
buffer’s capacity is not exceeded, check the documentation for your terminals, then 
calculate the safe number of entries and enter that into the scan ahead field. 
Use the following calculation to help you decide the safe number to store. (Assumption: 
your RF terminal can hold 400k in its buffer.) 

400 / (bar code length * 2) 
For example, if you regularly scan 13-character barcodes, your calculation would be: 

400 / (13 * 2) = 15.38 
Round the answer down to 15 and choose that number in the Scan Ahead field. 
 
Note: If you often must store more than 2-5 entries in the buffer, this may indicate a 

problem with the host application or the server. 

Length Check 

If you check Length Check, an error message is generated by the terminal if the scanned 
input is greater than the length of the field or if an attempt is made to enter a non-control 
key (Enter, Tab, arrows, function keys, etc.) after the field is filled.  

Note: Selecting Length Check disables the Auto Send key operation on the Keyboard 
and the Truncation option, below. 

Truncation  

If the length of the scanned input is greater than the length of the input field, you can 
choose to automatically cut the extra characters from the end of the scanned data.  

Note: If you enable this Truncation feature, automatic field wrapping is disabled. 

Stripping 

You can choose to eliminate trailing spaces and underscores from scanned input. Select 
Both to strip both spaces and underscores, or either Space or Score. 

Binary-128 

To enable the processing of binary code 128 bar codes on the terminal, check this box. 

Caution: Do not scan binary code 128 bar codes without this box being checked, or the 
results may be unpredictable. 

Data Mapping Object, Data Editor Object, and Decoder Control 
Object 

These are all advanced options. Refer to the Scanner Mapping section in chapter 4, 
“Advanced Options” for more information on the content and format of this feature. 



Configuring Options 

  PowerNet Twin Client Reference    •    September, 2003 3-10

Scanner Type 

Choose the type of scanner that is specific to your terminal. If you do not know, read 
your terminal’s manual for scanner type usage. Values used are specific to unique 
terminal types and cannot be interchanged. Your choice signals PowerNet Twin Client 
on a remote terminal which scanner type to use for input.  

Configuring with the Log Levels Tab 
A log is a file of network activity. Examining a log file can show information useful for 
system diagnostics.  

 

Generally leave log levels set to 0 (zero) for normal operation. For diagnostic situations 
only, a log level of 1 or 2 usually provides enough information for troubleshooting.  
Exercise care in setting these logging levels because the log files themselves are 
maintained on the remote RF device. If you choose to leave the log files active, the data 
that accumulates consumes space on the terminal’s virtual disk.  

General  

Defines the general logging level for the handler. There are 10 log levels, from 0 to 9, 
with a level of 9 collecting the most information. Default is zero (0). 

Display  

Defines the level of logging for host and terminal display logging. A level higher than 7 
results in a hex dump of the displays. Default is zero (0). 

Formatter  

Defines the level of logging for the screen formatting routines. Default is zero (0). 
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Dialog  

Defines the level of logging for dialog routines. Default is zero (0). 

Datastream  

Refers to the emulation datastream parsing information. Default is 0. 

A log file is created on the c:\ of the terminal called rf.log. To get it off the terminal, run 
ld.bat at the DOS prompt, and from Twin Client Manager, select Terminal and then 
Receive File from Terminal and type rf.log for the name of the file. The received file is 
stored in the \\Twinclient folder on the PC. 

Configuring the Timers Tab 
By using the Timers tab, you can determine how the RF terminal radio timer performs 
when interacting with the host application. These timing parameters may be modified to 
adjust the radio performance when interacting with the host application – which may, in 
turn, increase the battery life of the terminal.  

 

Timers 
The following timers help keep sessions active, or help you increase the life of your 
terminal’s battery by starting power saving shutdowns. 
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Radio 

Type the length of time, in seconds, during which the terminal activates the radio and 
waits for a response from the host application. After the wait-time is exceeded, an error 
message is displayed on the terminal. Decreasing the value increases battery life since 
the radio becomes inactive for long periods of time. Default is 120 (2 minutes). 

Power  

Type the length of the time, in seconds, after which inactivity from the scanner, 
keyboard, or radio results in a power saving shutdown of the terminal. Default is 300 (5 
minutes). This does not occur if the terminal is in session with the host. 

Backlight  

Type the time, in seconds, during which the terminal’s display backlight remains on after 
keyboard or scanner input. When set to a value other than 0, the terminal turns on the 
backlight for the amount of time specified. Frequent backlight use reduces battery life, 
requiring that the battery need recharging more often. 

Keepalive (3270, 5250 only) 
This group of options defeats RF terminal connection timeouts by having the PowerNet 
server send a keystroke to the host. Normally, a terminal session with the host is 
terminated if there is no notification within a specific time interval. This keystroke 
appears to be from the terminal and keeps the terminal session alive. 

Minutes  

The site administrator should supply this timeout interval in minutes. Valid data entries 
are 0–99 minutes. Default, zero (0), turns this timer off. 

Send Key  

Choose the key that is sent to the host if you have chosen to use the Keepalive function, 
above. The default value is noop, which disables the Keepalive function. The selections 
are pf1-pf24, pa1-pa3, enter, tab, bktab, clear, sysreq, e_eof, reset, noop, and attn. 

Collection Timer (vt100, vt220, hp700 only) 
Specifies the number of milliseconds the terminal waits after receiving data from the host 
before processing the data. This setting is used to avoid sending intermediate screens to 
the terminal, resulting in unnecessary RF traffic and rapidly changing screens on the 
terminal.  

For example, many applications display the “background” data for a screen then delay 
while the actual data is prepared for display. Without a proper collection timer setting, 
the terminal would display the background and then be updated again with the 
foreground data when it was ready. By using this collection timer, only one screen 
update is sent to the terminal, with all of the data in it. The default value is 100. Adjust 
the collection time to 30-50ms if Mode on the Keyboard tab is set to char. 



  Configuring Alarms with the Alarm Tab 

PowerNet Twin Client Reference   •    September, 2003   3-13

Configuring Alarms with the Alarm Tab 
You can adjust parameters to determine how the RF terminal alarm (beep) function 
performs when interacting with the host application by using the Alarm tab.  

 

Mode  
Defines the operation of the audible alarm and scanner light on the terminal. Default is 
bell.  
• = Off disables the audible alarm. 
• = Bell enables the audible alarm as a double beep. 
• = Flash enables the scan indicator light as the alarm – no audible alarm sounds.  
• = Both enables the double beep and the scan indicator light as the alarm.  
• = Spec1 enables the audible alarm as a single beep.  
• = Spec2 enables a single beep and the scan indicator light as the alarm. 

Volume  
Choose the volume of the audible alarm on the terminal. Default is hi. 

Alarm Duration & Frequency 
The next two options, duration and frequency, enable you to configure alarm sounds 
differently to allow users to tell the difference between alarms and scan decode tones. 
Use these with Mode set to spec1 or spec2. 
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Duration  

Set the length of time in milliseconds that you want the audible alarm on the terminal to 
sound. Default is 150. 

Frequency  

Set the frequency of the audible alarm on the terminal in Hertz. Default, zero (0), 
represents the factory set, optimum default frequency for the particular model of 
terminal. 

Allow Multiple  
Check this box if you want to enable multiple alarm commands generated by the host 
application in a single terminal update sequence. This means that if the host sends down 
multiple bells to a screen, the terminal alarm beeps as set for each of the bell commands. 
If this box is not checked, the bells are combined and the terminal only gives one alarm.  

Scan Duration & Frequency 
The next two options, scan duration and frequency, enable you to configure scan sounds 
differently to allow users to tell the difference between alarms and scan decode tones.  

Scan Duration  

Set the duration of the audible alarm generated by a scan operation on the terminal, in 
milliseconds. Default is 300. 

Scan Frequency  

Set the pitch of the audible alarm generated by a scan operation on the terminal, in Hertz. 
Default, zero (0), represents the factory set, optimum default frequency for the particular 
model of terminal.  

By Attribute (for 3270 only) 
The next two options, protected and unprotected, enable you to choose alarm processing 
by field input attribute. Values are off (the default), pen for lightpen scanning, num for 
numeric, hi for high intensity, and hal for high intensity and lightpen. 

Protected  

Check this box to enable alarms on protected fields. 

Unprotected  

Check this box to enable alarms on unprotected fields. 
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Alternate (5250 only) 
Check this box to allow the host application to place a single digit display character at a 
specified row and column within the presentation space for conversion to the indicated 
number of alarms at the terminal. 

Row  

When Alternate (above) is checked, row is x; it specifies the zero relative row number in 
the host presentation space where the alternate alarm digit is found. 

Column  

When Alternate (above) is checked, column is y; it specifies the zero relative column 
number in the host presentation space where the alternate alarm digit is found. 

Configuring with the Printer Tab 
Printer shows parameters that you may adjust to determine how a printer attached to the 
RF terminal interacts with the host application.  

 

Type  

Defines the type of printer attached to the terminal. The default is none.  
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Init Object 

This feature of PowerNet Twin Client allows you to define printer commands to be sent 
to the terminal immediately after the terminal establishes a session.  

Flag Byte (most options below are 3270,5250 only) 

The presentation space of each screen from the host is examined for a beginning flag 
byte. It signals that the data following is printer data rather than screen data. The starting 
byte location is defined in the following Flag Row and Flag Column.  

The handler continues searching the data stream for another flag byte to signal the end of 
the print data. In other words, the data encapsulated between the two Flag Bytes are sent 
to the printer.  

Choose for the flag byte a number within a range of 0 to 127 that normally does not 
occur within the host application nor is contained within the print data. 

Flag Row The row (within a range of 0 to23) where the flag byte (defined above) starts. 
It allows the software to narrow its search for the flag byte. It is a zero-based number 
where the lowest row (top of the screen) is zero (0). Default is zero. 

Flag Column The column number (within a range of 0 to79) for the flag byte. It is a 
zero-based number where the lowest row (leftmost side of the screen) is zero (0). Default 
is zero. 

Clear Key  

Once printing is completed, this key is sent to the host application to signal that the 
printer has completed the printing task. This signal ensures that the printer is not 
instructed to print again before finishing printing the current task. The selections are pf1-
pf24, pa1-pa3, enter, tab, baktab, clear, sysreq, e_eof, reset, noop, and attn.  

Start  

Specifies a unique character sequence that, when encountered in the host display area, 
indicates that all subsequent characters up to but not including the End character 
sequence are to be transmitted to the printer attached to the terminal. The default value is 
blank which also indicates that this option is not in use.  

Note: The print data limit is 1.5 K. 

End  

Specifies a unique character sequence that terminates collection of data from the host 
display area for transmission to the printer attached to the terminal. The default value is 
blank which also indicates that this option is not in use. 

Start Convert  

Specifies a unique character sequence within the print data collected with the Start and 
End options that indicates the subsequent character pairs are hexadecimal values that are 
converted to binary. A blank value, default, indicates this option not in use. 
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End Convert  

Specifies a unique character sequence that terminates binary conversion. Default, blank, 
indicates that this option is not in use. 

LXE Option  

Check the box and the scanner operates with LXE applications.  

Convert Flag Byte (3270 only) 

Specifies the ASCII value in a 0 to 127 range, in decimal, that is converted according to 
the setting of the Conversion option if encountered in a sequence of print data. This is 
the byte used as the signal byte for printing. The presentation space of each screen from 
the host is examined for this byte. It signals that the data following is printer data rather 
than screen data. The starting byte location must be known. The software then 
continuously looks for another flag byte to signal the end of the print data. The selection 
of the flag byte should not occur in normal print data. Default, zero (0), disables this 
function. 

Conversion (3270 only) 

Specifies what the Flag Byte is converted to. The options are crnl, cr, and nl which 
represent ASCII carriage return new line, carriage return, and new line, respectively. The 
default value is crnl. 
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Using the Miscellaneous Tab 
This screen becomes activated as a display area for the VT Extension Group, the Data 
Stream Group, and Answerback.  

 

Extended Command Group (3270,5250 only) 

Start  

Specifies a unique character sequence that, when encountered within the host display, 
indicates that all subsequent characters up to but not including the End sequence, are to 
be interpreted as an Extended Command. Default, blank, indicates that the option is not 
in use. 

End  

Specifies a unique character sequence that terminates the Extended Command. 

Data Stream group (3270 only) 

Send All MDT  

Determines how fields with the Modified Data Tag bit set are selected for transmission 
to the host application. If set to no, only unprotected fields modified by the terminal 
operator are transmitted. If set to yes, all fields with the MDT bit set (protected and 
unprotected) are transmitted. Default, yes, is checked. 

Send NULL  

If checked, all null characters are transmitted to the host.  
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Note: For AS400 hosts, this field should be checked. 

Answerback (vt100, vt220, hp700 only) 
This text input field defines the response returned to the host application when the 
answerback command (as defined under VT/HP emulation) is received. If this value is 
left blank, the terminal automatically returns an ASCII string corresponding to the 
emulation in use (vt100, vt220, or hp700). 

Non-graphic characters may be embedded in the answerback field using the escape 
sequence  \nnn , where the backslash is followed by three digits representing the octal 
value. Inserting the sequences “$A”, “$B”, “$C”, and “$D” into the answerback string 
results in a substitution of four octets, three octets, two octets, and the last octet of the 
terminal IP address, respectively, as shown below.  

$A - all four octets of the IP address (206.183.067.226) 
$B - the last 3 octets (183.067.226) 
$C - the last 2 octets (067.226) 
$D - the last octet (226) 

Given a terminal with an IP address of 206.183.67.226, the following examples 
demonstrate how substitution and non-graphic escape sequences are processed.  
 
Answerback   Data Sent in Response to Answerback Command 
$A   206.183.067.226 
RF$A   RF206.183.067.226 
RF$A\015  RF206.183.067.226<carriage return> 
$B   183.067.226 
RF$B   RF183.067.226 
RF$B\015  RF183.067.226<carriage return> 
$C   067.226 
RF$C   RF067.226 
RF$C\015  RF067.226<carriage return> 
$D   226 
RF$D   RF226 
RF$D\015  RF226<carriage return> 
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Chapter 4 • Advanced Options 

 Defining Configuration Objects 
Operation of PowerNet Twin client can be tailored to meet your special requirements, 
ease operators’ workloads, and increase productivity without custom programming. You 
can create objects that modify Twin Client operation and include them in your terminals’ 
configuration file. These objects can be used to: 
• = Alter the operation of the keyboard, scanner, printer, and display 
• = Automate portions of the terminal session. 

The objects can be created and modified directly from within the Keyboard, Display, 
Scanner, and Printer tabs of the PowerNet TN Client Configuration Utility screen by 
clicking on the Edit button next to the object name field. However, to make the 
explanations easier to understand, all procedures are assumed to start with clicking on 
the Object Editors menu, selecting the appropriate object type, and designing the editors.  

After you have defined all the objects, you include them in your terminal configuration 
by clicking on and choosing them from the tabs.  

 

Relating Terms 
The following terms mean the same thing; they simply are named slightly differently 
depending upon if they are on the object editor menu list or on the configuration tabs. 
 

Object Editors Menu Configuration Tab 
Options 

Keyboard/Mapping Mapping Object 
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Keyboard/Macros Macro Object 

Scanner/Data Mapping Data Mapping Object 

Scanner/Data Editing Data Editor Object 

Scanner/Decoder Control Decoder Control Object 

Display/Mapping Mapping Object 

Display/Formatting Formatter Object 

Printer/Init Init Object 

Dialog Dialog Object (display) 

Screen Capture  

Designing Keyboard Objects 
Keyboard Mapping 
This feature of PowerNet Twin Client allows you to map key(s) on your terminal to a 
particular host key. For example, you can specify that pressing the 4 key on the terminal 
sends a PF24 key stroke to the host application. 

1. From the PowerNet TN Client 
Configuration utility screen, select 
Object Editors, Keyboard 
Mapping. The PowerNet Terminal 
Type screen appears. 

 
2.   Select the type of terminal keyboard you are using and click OK. The PowerNet 

Keyboard Mapper screen appears.  

Note: The following screen shot is an example of one of the many Key Mapper terminal 
screens that may appear. 
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The Keyboard Mapper screen has a mock-up of a keypad on the left and options for key 
remapping on the right. When you select a key on the keypad mock-up, available remap 
options appear on the right.  

State modifiers, such as “alpha lock” or “shifted” are keys on this keyboard that can be 
used in combination with the key you have selected. They vary depending upon the 
terminal you select.  

Transmit possibilities allow for many actions or characters, such as “backtab” or “tilde” 
that might not appear on the terminal keyboard.  

Mode defines what happens with the key combination you select. The list of possible 
modes is as follows:  
 

Mode 

local Handles the specified key locally on the terminal; sends (if required, 
as in the case of alphanumeric characters) when Enter is pressed on 
the terminal. 

xmit Transmits the key immediately to the host. 

lamp Turns on the terminal backlight. 

light Lightens the display contrast. 

dark Darkens the display contrast. 

noop Do nothing. 

edleft Non-destructive backspace (move) to the left of the cursor within a 
field. 

edrite Non-destructive space (move) to the right of the cursor within a field. 

edbksp Destructive backspace (move) to the left of the cursor within a field. 
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Mode 

edeeof Destructive space (move) to the right of the cursor within a field, to the 
end of the field. 

edefld Edit mode. 

lhelp Displays the terminal ID, date, time, and terminal software version 
number. 

scan Sets a key that, when pressed, triggers the scanner to scan. 

Creating a Keyboard Mapping Object 

To create a Keyboard Mapping Object, complete the following steps. 

1. Select a key with the mouse from the keypad mock-up. It turns red. 
• = Choose the state modifier “unmodified” to use the key alone, then choose the 

mode and information to transmit that you wish. 
• = Choose the desired state modifier to make a key combination, then choose the 

mode and information to transmit that you wish. 

2. When you have finished defining desired keys, select File, and then Save As. 

 
3. Enter a name for the new keyboard mapping object and click Yes to save the file you 

have created. The PowerNet TN Client Configuration Utility screen appears. 

To modify a mapping object: 

1. Select the key to be modified from the keypad mock-up, using the mouse, arrow or 
tab keys.  

2. Select the keyboard state modifier with which the key is to be modified.  

3. Click to select the particular key code to implement. Key codes can be selected by 
pressing the first letter of the desired code repeatedly until the code appears on the 
screen. You may also use the Up or Down arrow keystrokes to scroll through the 
transmit list and select the key code. 

4. Select File, and then Save to save your changes. 
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Linking a Keyboard Mapping Object to a Configuration 
1. Using the PowerNet TN Client Configuration Utility, select the Keyboard tab. 

2. Select a mapping object from the Mapping Object pull-down list. 

3. Select File, and then Save As to save your PowerNet Twin Client configuration. 
Either choose an existing configuration file to attach the mapping object to, or enter 
a new name for a new configuration. 

Later, when you program your RF terminal using the PowerNet Twin Client 
Configuration utility, your keyboard mapping file is loaded. 

Keyboard Macros 
This feature of PowerNet Twin Client allows you to assign special characters, or 
sequences of characters, to specific keys. As a result, when the terminal key is pressed, 
the macro is sent to the host. There are no pre-defined keyboard macros. A macro is user-
defined. Macros include pf1 through pf24, in addition to the following. 
 
Attn Escape Pa3 
Bktab Find Print 
Bksp Fm  Redraw 
Bottom Home Refresh 
Clear Ins Remove 
Del Localexit Reset 
Dup Newl Return 
End Num Select 
Enter Nullend Sysreq 
Eof Pa1 Tab 
Erase Pa2 Top 
 

Macros are constructed using the following format: 
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<keyname>=<macro string> 

where <keyname> is the terminal key’s name and <macro string> is the macro text 
assigned to that specific key.  

For example, if you wanted to send the text “vt100” followed by moving the cursor to a 
new line when a user presses the PF9 key, you would define the following in the macro 
object file: pf9=vt100\015;

Multiple keyboard macros can be defined in a single macro object, however, each line of 
the macro object must be terminated by a semicolon.  
 
Macro: Pressing the terminal key causes: 
pf1=login5\015; PF1 sends “login” followed by CR 
pf2=passwd5\015; PF2 sends “passwd”  followed by CR 
pf3=vt100\015; PF3 sends “vt100” followed by CR 
pf4=appname\015; PF4 sends “appname” followed by CR 

Note: \015 represents the octal value for “carriage return”. See Octal Values, below. 

Using Octal Values 

The following table lists the octal value and the associated ASCII equivalent character 
for special characters that may need to be incorporated into macro strings. 
 

Octal Value ASCII  Octal Value ASCII 

000 NUL  022 DC2 
001 SOH  023 DC3 
002 STX  024 DC4 
003 ETX  025 NAK 
004 EOT  026 SYN 
005 ENQ  027 ETB 
006 ACK  030 CAN 
007 BEL  031 EM 
010 BS  032 SUB 
011 HT  033 ESC 
012 LF  034 FS 
013 VT  035 GS 
014 FF  036 RS 
015 CR  037 US 
016 SO  040 SP 
017 SI  073 ; 
020 DLE  075 = 
021 DC1    

Creating a Keyboard Macro Object 

To create a Keyboard Macro Object, complete the following steps. 
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From the PowerNet TN Client Configuration utility screen, select Object Editors, and 
then Keyboard Macros. The Select Object Editor file screen appears. 

 
 

1. Enter a name for the macro you are creating and click Open. 

2. Click Yes when asked if you want to create a new file. 

3. Define the desired keyboard macro(s) as described earlier in this section. 

4. Select File, and then Exit. Click Yes, when prompted, to save the macro object you 
have created. 

Linking a Keyboard Macro Object to a Configuration 
1. Using the PowerNet TN Client Configuration Utility, select the Keyboard tab. 

2. Select a macro object from the Macro Object pull-down list. 

3. Select File, and then Save As to save your PowerNet Twin Client configuration. 
Either choose an existing configuration file to attach the mapping object to, or enter 
a new name for a new configuration. 

Later, when you program your RF terminal using the PowerNet Twin Client 
Configuration utility, your keyboard macro file is loaded. 

Viewing a Sample Keyboard Macro Object 
1. Using the PowerNet TN Client Configuration Utility, select the Keyboard tab. 

2. Click the Edit button at the right side of the Macro Object line. The Select Object 
Editor file screen appears, listing macro files already created. 

3. Select an existing file by clicking twice on the name. It automatically starts Notepad 
and displays the macro file. 
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You can edit the existing text and save it as a new file. 

Designing Scanner Objects  
Scanner Mapping  
Scanner Data Mapping allows you to map a specific barcode to a keystroke that is 
automatically sent to the host. For example, a barcode such as $G can be transformed 
into a 5250 Enter keystroke. 

Entries in scanner data mapping objects are constructed using the following format: 
barcode = keystroke; 

barcode is the scanned barcode and keystroke is the keystroke to send when the barcode 
is scanned.  

Creating a Scanner Data Mapping Object 

With data mapping, you can create a unique barcode (such as $G) and assign it to send a 
function (such as Tab) when scanned. For example, you can alternate scanning this “Tab 
barcode” with scanning inventory barcodes to create a tab-delimited inventory list. 

 

When you are ready to create or edit your Scanner Macro Object file, complete the 
following steps. 

1. Using the PowerNet Twin Client Configuration Utility, select Object Editors, and 
then Scanner Data Mapping. The Select Object Editor file screen appears. 

2. Enter a name for the map you are creating and click Open. 

3. Click Yes when asked if you want to create a new file. 

4. Define all of the necessary scanner maps, using the guidelines previously explained. 

5. Select Exit from the File menu. 

6. Click Yes, when prompted, to save the object you have created. The PowerNet Twin 
Client Configuration tool then becomes active on the screen. 

Linking the Scanner Mapping Object to a Configuration 
1. From the PowerNet TN Configuration Utility, select the Scanner configuration tab. 
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2. Select the object name that you have just saved from the Mapping Object pull-down 
list. 

3. Select Save from the File menu to save your configuration. 

4. Later, when you download the configuration to the terminal using the PowerNet 
Twin Client Configuration utility, the scanner object is included. 

Scanner Data Editor  
PowerNet Twin Client gives you the ability to automatically edit scanned data based on 
its pattern. This data editor allows you to manipulate data entry without requiring 
complex host application modification or costly re-labeling of barcoded items.  
 

 

Scan editing is based on the length (Size) and pattern of the scanned data (Recognition). 
Once the pattern of the scanned entry has been recognized, one or more operations 
manipulate the scanned data. 

Recognition building blocks are comprised of: 
 A Alpha character 

N Numeric character 
* Any character 
= Must match next character 

Operational building blocks are comprised of 
 X Delete character 

* Copy as is 
( ) Substitute 
““ Insert 

Consider the following table that illustrates how the recognition and operation building 
blocks manipulate scanned data. 
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Scanned 
Value 

Size 
(length) 

Recognition 
pattern  

Operation End Value 

PN-1245 7 AA=-NNNN “F”******* FPN-1245 

5A5567BBAT 10 ********** **********”M” 5A5567BBATM 

TGR87 5 =T=GAN* **(S)** TGS87 

78-RHG 6 NN=-AAA **X*** 78RHG 

Creating a Scanned Data Editing Object 

To create a Scanned Data Editing object, complete the following steps. 

1. Using the PowerNet Twin Client Configuration Utility, select Object Editors, and 
then Scanner Data Editing. The PowerNet Scan Editor screen appears. 

2. Enter a name for the object you are creating and click Open. 

3. Define all of the necessary scanner maps, using the guidelines previously explained. 

4. Select File, and then Save As and enter a name when prompted. Click Save. The 
PowerNet Twin Client Configuration tool then becomes active on the screen. 

Linking a Scanned Data Editor to a Configuration 
1. Using the PowerNet Twin Client configuration tool, select the Scanner tab. 

2. Select the Scanned Data Editing object that you have just saved from the Data Editor 
Object pull-down list. 

3. Click on the desired entry to link it to the PowerNet Twin Client configuration 

4. Select File, and then Save to save your new configuration. 

5. Later, when you download the configuration to the terminal, the object will be 
included. 
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Variable Length Operation 
 

 
 
The scan editor allows operations to be done on variable length labels. 
 
The variable length character is the  ~  (tilde) and it must go into the operation 
side of the rule. 
 
Rules: 
1. The size must be set to zero. 
2. The tilde must be in the operation side. 
 
Example: This example will delete the first character from any bar code size that 
                  starts with any ALPHA character. 

Scanner Decoder Control 
The operation of the scan decoder can be modified with the Decoder Control object. Any 
of the supported barcodes can be enabled or disabled, and the characteristics of each 
barcode can be modified using the Decoder Control Editor shown below. 

Extended command sequences for dynamic scan decoder control are described later in 
this section. 
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Creating a Decoder Control Object 

To create a Scanned Decoder Control object, complete the following steps. 
1. Using the PowerNet Twin Client Configuration Utility, select Object Editors, and 

then Scanner Decoder Control. The PowerNet Decoder Control screen appears. 

2. Click to choose a manufacturer and terminal type from the pull-down lists. 

3. Click on the desired bar code types in the Symbology window to enable or disable 
them.  

4. Choose from the options associated with the selected bar code types. 

5. Select File, and then Save As when you have completed the definition for your Scan 
Decoder Object. 

6. Enter a name and click Save. 

Linking a Decoder Control Object to a Configuration 
1. Using the PowerNet Twin Client configuration tool, select the Scanner tab. 

2. Select the object that you have just saved from the Decoder Control Object pull-
down list. 

3. Click on the desired entry to link it to the PowerNet Twin Client configuration. 

4. Select File, and then Save to save your new configuration. 

5. Later, when you download the configuration to the terminal, the object will be 
included. 

Note: When the terminal session is started, PowerNet checks for the presence of a 
decoder control object. If the object exists, the first action taken is to disable all 
barcodes. This means that you must add command lines to turn back on all of the 
codes desired. If the file does not exist or does not contain any commands, then all 
barcodes are enabled. 

Note: When turning a decoder on, Minlen, Maxlen, and Depend all default to zero. If the 
zero state is not wanted, add the modifying line. 

Extended Commands 
The host application can control the terminal's scanner and keyboard dynamically, while 
the terminal is in session, by displaying in the host application presentation the extended 
commands described in the following sections.  

The format and content of the commands that control the scan decoder are described in 
the following sub-sections. 

CODABAR Control 

PowerNet TN Extended Command: 

<ESC>[?0;<state>;<minlen>;<maxlen>;0z 
• = State: Disable/enable codabar scanning. 0=disabled, 1=enabled. 
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• = Minlen: Minimum valid barcode length. Valid values are 1–54. 
• = Maxlen: Maximum valid barcode length. The maximum length must be greater 

than or equal to the minimum length. Valid values are 1–54. 

CODE 11 Control 

PowerNet TN Extended Command: 

<ESC>[?11;<state>;<minlen>;<maxlen>;<depend>z 
• = State: Disable/enable code 11. 0=disabled, 1=enabled. 
• = Minlen: Minimum valid barcode length. Valid values are from 4 to 54. 
• = Maxlen: Maximum valid barcode length. The maximum length must be greater 

than or equal to the minimum length. Valid values are from 4 to 54. 
• = Depend: Number of check digit. Valid values are 0, 1 or 27. 

CODE 128 

PowerNet TN Extended Command: 

<ESC>[?2;<state>;<minlen>;<maxlen>;0z 
• = State: Disable/enable code 128 scanning. 0=disabled, 1=enabled. 
• = Minlen: Specify minimum valid barcode length. Valid values are from 1 to 54. 
• = Maxlen: Specifies the maximum valid barcode length. The maximum length must 

be greater than or equal to the minimum length. Valid values are from 1 to 54. 

CODE 39 

PowerNet TN Extended Command: 

<ESC>[?3;<state>;<minlen>;<maxlen>;<depend>z 
• = State: Disable/enable code 39 scanning. 0=disabled, 1=enabled. 
• = Minlen: Specifies the minimum valid barcode length. Valid values are from  

1 to 54. 
• = Maxlen: Specifies the maximum valid barcode length. The maximum length must 

be greater than or equal to the minimum length. Valid values are from 1 to 54. 
• = Depend: Disable/enable full ASCII code 39 interpretation. 0=disabled, 1=enabled. 

CODE 49 

PowerNet TN Extended Command: 

<ESC>[?4;<state>;0;0;0z 
• = State: Disable/enable code 49 scanning. 0=disabled, 1=enabled. 

CODE 93 

PowerNet TN Extended Command: 

<ESC>[?5;<state>;<minlen>;<maxlen>;0z 
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• = State: Disable/enable code 93 scanning. 0=disabled, 1=enabled. 
• = Minlen: Minimum valid barcode length. Valid values are 1–54. 
• = Maxlen: Maximum valid barcode length. The maximum length must be greater 

than or equal to the minimum length. Valid values are 1–54. 

D 2 of 5 

PowerNet TN Extended Command: 

<ESC>[?6;<state>;<minlen>;<maxlen>;0z 
• = State: Disable/enable code 25. 0=disabled, 1=enabled. 
• = Minlen: Minimum valid barcode length Valid values range from 1–54. 
• = Maxlen: Maximum valid barcode length. The maximum length must be greater 

than or equal to the minimum length. Valid values range from 1–54. 

INTERLEAVED 2 OF 5 

PowerNet TN Extended Command: 

<ESC>[?7;<state>;<minlen>;<maxlen>;0z 
• = State: Disable/enable interleaved 2 of 5 scanning. 0=disabled, 1=enabled. 
• = Minlen: Minimum valid barcode length. Valid values range from 1 to 54. 
• = Maxlen: Maximum valid barcode length. The maximum length must be greater 

than or equal to the minimum length. Valid values range from 1–54. 

EAN-13 

PowerNet TN Extended Command: 

<ESC>[?8;<state>;0;0;0z 
• = State: Disable/enable EAN-13 scanning. 0=disabled, 1=enabled. 

EAN-8 

PowerNet TN Extended Command: 

<ESC>[?9;<state>;0;0;0z 
• = State: Disable/enable EAN-8 scanning. 0=disabled, 1=enabled. 

PLESSEY/MSI 

PowerNet TN Extended Command: 

<ESC>[?10;<state>;<minlen>;<maxlen>;<depend>z 
• = State: Disable/enable code MSI scanning. 0=disabled, 1=enabled. 
• = Minlen: Minimum valid barcode length Valid values are from 4 to 54. 
• = Maxlen: Maximum valid barcode length. The maximum length must be greater 

than or equal to the minimum length. Valid values are from 4 to 54. 
• = Depend: Specifies the number of required check digits. Valid values are 0, 1, or 2. 
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UPC-A 

PowerNet TN Extended Command: 

<ESC>[?13;<state>;0;0;0z 
• = State: Disable/enable UPC-A scanning. 0=disabled, 1=enabled. 

UPC-E0 

PowerNet TN Extended Command: 

<ESC>[?14;<state>;0;0;0z 
• = State: Disable/enable UPC-E0 scanning. 0=disabled, 1=enabled. 

UPC-E1 

PowerNet TN Extended Command: 

<ESC>[?15;<state>;0;0;0z 
• = State: Disable/enable UPC-E1 scanning. 0=disabled, 1=enabled. 

Supplemental Barcode Handling (UPC/EAN) Options 

PowerNet TN Extended Command: 

<ESC>[?12;<state>;<minlen>;<maxlen>;<depend>z 
• = State: This flag should always be set to one. 
• = Minlen: Specifies if two character supplementals are enabled/disabled (only 

applies to transmit mode 1). 0=no codes with two character supplementals decoded, 
1=codes with two character supplementals decoded. 

• = Maxlen: Indicates if five character supplementals are enabled/disabled (only 
applies to transmit mode 1). 0=no codes with five character supplementals decoded, 
1=codes with five character supplementals decoded. 

• = Depend: Specifies the supplemental transmit mode. 0=no supplementals 
transmitted to host, supplemental enable/disable ignored. 1=only codes with the 
appropriate supplemental (from minlen/maxlen) decoded. 2=all codes sent as is, 
supplemental enable/disable ignored. 

Disabling All Decoders 

PowerNet TN Extended Command: 

<ESC>[?z 

This command is used to disable all barcodes on the handheld. Typically this would be 
issued before turning on an individual barcode type just to make sure of the state of the 
active barcodes. 

Determining Input Mode 

The input mode parameter sent from the application controls (via the host application) 
decides whether the terminal accepts input from the keyboard, the scanner or both. 
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Sending this sequence to the terminal controls the characteristics of the input fields 
following.  

The sequence used for this function is: 

<ESC>[!1;<mode>z.  

The mode parameter can be one of the following: 
 

Mode Action Description 

0 
(default) 

Scan and Key Data initially accepted from either the keyboard or 
scanner. Scanning, allowed on a partially keyed 
field, causes the keyed data to be discarded and the 
scanned data to be accepted. 

1 Scan or Key Data initially accepted from either the keyboard or 
scanner. Scanning is not allowed on a partially 
keyed field. If the operator clears the field then 
scanning is again allowed.  

2 Scan Only Data accepted only from the scanner. Use caution 
when using this command, bad barcode can block 
the user from completing input. 

3 Key Only Data accepted only from keyboard, the scanner off. 

Dynamic Keyed Input Data Control 
The terminal keyboard input characters can be controlled dynamically, while the 
terminal is in session, by sending the extended command sequence to the terminal, as 
described in the following. 

<ESC>[!2;<mode>z.  

The mode parameter can be one of the following. 
 

Mode Description 

0 
(default) 

Accepts characters between 0x20 and 0x7F. 

1 Accepts alphabetic characters only. 

2 Accepts numeric characters only. 

3 Accepts alphanumeric characters only. 

For example, to allow keyboard input of numeric characters only, use the following 
sequence: 
 <ESC>[!1;3z<ESC>[!2;2z 
(HEX equivalent: 1B 5B 21 31 3B 33 7A 27 5B 21 32 3B 32 7A)

To reset the terminal back to normal input, use the following sequence: 
 <ESC>[!1;0z<ESC>[!2;0z 
(HEX equivalent: 1B 5B 21 31 3B 30 7A 27 5B 21 32 3B 30 7A) 
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Designing Display Objects 
Display Mapping 
This feature of PowerNet Twin Client allows you to substitute characters so the terminal 
displays correctly, if a portion of the character sets between your terminal and your 
server are incompatible. 

Display Mapping object files are constructed using the following syntax (pattern): 

<character from host> = <character desired>, xlat;  

where <character from host> is the character sent by the server, and <character desired> 
is the DOS character wanted on the terminal’s screen. Each line ends with xlat and a 
semicolon. 

Multiple character mapping definitions can be specified in a single file, however, each 
line containing a character definition must end with a semicolon.  

 

The sample display character mapping above shows an important concept worth noting: 
an explanation of the object mapping is put into the file to remove any later doubts of the 
value. The # in front of a line shows that it is a remark and will not show on the 
terminal’s screen. 

Creating a Display Mapping Object 

When you are ready to create or edit your Display Mapping Object file, complete the 
following steps. 

1. From the PowerNet TN Client Configuration utility screen, select Object Editors, 
and then Display Mapping. The Select Object Editor file screen appears. 

2. Enter a name for the mapping object you are creating and click Open.  

3. Click Yes when asked if you want to create a new file. 

4. Define all of the necessary display macros, using the guidelines explained 
previously. 

5. Select File, and then Exit. Click Yes, when prompted, to save the mapping object 
you have created.  
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Linking the Display Mapping Object to a Configuration 
1. Using the PowerNet Twin Client Configuration Utility, select the Display 

configuration tab. 

2. Select a macro object from the Mapping Object pull-down list. 

3. Select File, and then Save As to save your PowerNet Twin Client configuration. 
Either choose an existing configuration file to attach the mapping object to, or enter 
a new name for a new configuration. 

Later, when you download the configuration to the terminal using the PowerNet Twin 
Client Configuration utility, your display mapping file is included. 

Display Formatting 
See Chapter 6. 

Designing Printer Objects  
This feature of PowerNet Twin client gives you the capability of determining how the 
terminal’s printer performs when it interacts with the host application.  

Printer Initialization 
This object editor allows you to download an initialization file for the printer that defines 
printer commands to be sent to the terminal immediately after the terminal establishes a 
session.  

Note: The upper limit of print data is 1.5 K. 

Creating a Printer Init Object 

To create your Printer Init Object, complete the following steps. 

1. Using the PowerNet Twin Client Configuration Utility, select Object Editors, 
and then Printer Init. The PowerNet Select Object Editor File screen appears. 

2. Enter a name for the object you are creating and click Open. 

3. Click Yes when asked if you want to create a new file. 

4. Define the desired Printer macros, using the guidelines previously explained. 

5. Select File, and then Exit. Click Yes, when prompted, to save the macro object 
you have created. 

Linking a Printer Object to a Configuration 
1. Using the PowerNet TN Client Configuration Utility, select the Printer tab. 

2. Select the object that you have just saved from the Init Object pull-down list. 

3. Select File, and then Save As to save your new configuration.  
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4. Later, when you download the configuration to the terminal, the object will be    
        included. 

Designing Dialog Objects 
Dialog objects are often used to automate difficult or repetitive user interactions with the 
host application. You can create terminal screens, collect input, generate output, and 
make decisions based upon terminal keyboard or scanner input, and host application 
output. Dialog objects are executed automatically when a terminal session with the host 
is started. 

Creating a Display Dialog Object  

When you are ready to create your Display Dialog Object file, complete the following 
steps. 
2. From the PowerNet TN Client Configuration utility screen, select Object Editors, 

and then Dialog. The dialog editor RFScript screen appears. 

 
 

2.   Commands in the scrolling window on the right can be added or inserted into the 
dialog object displayed on the left by clicking on the Add or Insert buttons.  

3.  The view of the object window can be adjusted by clicking on the Up and Down        
      buttons, and commands can be deleted from the object by clicking on the Delete       
       button.  

Using Commands  

Commands are used to take action within a program. They can be used to perform such 
actions as comparing variables, delaying execution of the script program, clearing a 
terminal screen, displaying data on the terminal screen, and sending information to the 
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host application. If a command requires arguments, the box at the bottom left prompts for 
the required information. 

Following is the list of available commands. 
 

Commands 

Label Defines a target for the conditional branch commands Onfail, 
Equal, If, Host State, Host Scan, and the unconditional branch 
command, Goto. 

Goto Causes execution to begin unconditionally and immediately at the 
named target Label. 

On Fail Upon detection of a system error, execution continues at the 
named Label. 

Equals If the comparison is equal, branches to Label. Otherwise, 
execution continues with the next command. 

If If the conditions of the comparison operator are true, branches to 
Label. Otherwise, execution continues with the next command. 
The numeric value comparison operators, which treat the values 
being compared numerically, are = (equal). != (not equal), > 
(greater than), and < (less than). The string value comparison 
operators, which treat the values as character strings, are $= 
(equal) and $!= (not equal) 

Set Var Assigns a value to one of up to 36 variables. 

Change 
Var 

Adds to or subtracts from the value of a variable. 

Concat Adds characters to the end of a variable. 

Session Returns control of the session to the terminal operator. The 
operator returns control to the dialog object, at the next line, by 
pressing the key defined as the End Key in the Keyboard tab. 

Host On Initiates a TCP/IP connection to the host system. 

Host Off Terminates the TCP/IP connection to the host system. 

Host Scan Scans the host display for a value, and continues execution at the 
named label if the value is found. 

Host 
Update 

Refreshes the host display. This command is used after data has 
been sent to the host that may change the display, and prior to 
using the Host Scan or Host State conditional branch commands, 
or a Host Copy command. 

Host Send Transmits data and/or a keystroke to the host. 

Host Copy Copies characters from the host display to a variable. 

Host State If the state of the session matches the value supplied, execution 
begins at the named Label. The possible values are inactive, 
meaning the host session has not been established, and plu, which 
means the host session has been established. 
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Commands 

Settle Allows time for the host application to settle. 

Term 
Enable 

Initializes the terminal configuration parameters. 

Term 
Clear 

Clears the terminal display of all characters. 

Term 
Display 

Puts a value or the value of a variable on the terminal display. 

Term 
input 

Prompts the terminal operator to input data. 

Term No 
Echo 

Prompts the terminal operator to input data, which will not be 
echoed on the terminal display. 

Term Wait Waits for any input from the terminal. 

Term 
Logoff 

Terminates the connection to the wireless network. 

Exit Terminates execution of the dialog object. 

Sleep Suspends all activity for the specified number of seconds. 

Var Char Sets the character used internally by the dialog processor to 
indicate the name of a variable. The character is normaLoglly $. 
This command is used only when the first character of a value used 
in one of the conditional branching commands begins with $. 

Log Writes a message to the terminal log. 

Comment Inserts documentation in the dialog object. 

Screen Capture 
See Chapter 6. 
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Advanced 3270 Keyboard Options 
Clicking the Advanced button on the Keyboard tab brings up the Advanced 3270 
Keyboard screen. 

 

Attribute Key section 

The keys in this section give you the ability to set up an automatic transmission of data 
once the field is filled.  

Key 

Specifies the key that is sent to the host following scanned or keyed input when the field 
matches the selected attribute setting, as specified in Scan Field and Key field, 
following. This option overrides all other automatic keystroke generation, except for Last 
Field processing. The default key setting of noop disables this function. 

Scan Field 

The default value is off. Available values for this field are pen (for lightpen), num (for 
numerical), hi (for highlighted) and hal for high intensity and lightpen. 

Key Field  

The default value is off. Available values for this field are pen (for lightpen), num (for 
numerical), hi (for highlighted) and hal for high intensity and lightpen. 

Last Field Keys section 

The keys in this section specify the keybstrokes automatically generated following 
scanned input, or keyed input that fills the field, when the field is the last field on the 
host screen. This option overrides all other automatic keystroke generation when these 
conditions are met. 

Scanned Input  

Specifies the keystroke automatically generated if input is scanned into the last field. The 
default value is noop, which disables this function.  
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Keyed Input  

Specifies the keystroke automatically generated if input is keyed into the last field, and 
the field is filled. The default value is noop, which disables this function. 

Multiple Fields  

Specifies that last field key processing takes place only if the host display contains more 
than one input field and the conditions for keyed or scanned input are met. 

Key Wrap 

Check this box to enable long input strings to wrap to the next input field. 

Advanced Display Options for VT/HP 
Used only with VT100, VT220, and HP700, this mask, or screen, applies to reverse 
video to choose which attributes should be used for input. 

 

Attribute Mask 

Click to choose the video attributes to be recognized by the emulator and displayed on 
the terminal screen. Note that the blinking attribute will always display in bold on the 
terminal.  

Field Mask 

The VT100 and VT220 protocols do not support the more efficient block mode of 
operation that is standard in the 3270 and 5250 protocols because there are no VT100 or 
VT220 protocol commands for defining input fields. 

However, PowerNet makes it possible to simulate block mode operation by using video 
display attributes to define input fields. Each box checked in the Field Mask window 
indicates a video attribute that will be recognized as an input field specification by the 
emulator. During a terminal session with a host, whenever the cursor is positioned on 
character with the selected attribute(s), all characters to the right of that position with the 
same attribute are interpreted to specify the length of the input field. 
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Blink Mask 

Click to choose the characteristics of an incoming video field that will cause it to be 
displayed in blinking text on the terminal screen. Note that the blinking attribute is 
always converted to bold on the terminal display. 
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Chapter 5 • New Environ Telnet 
Extension 

Creating Named Variables 
The New Environ Telnet extension, also known as Workstation ID, is a mechanism for 
providing named variables with values to the host system via a Telnet negotiation at the 
beginning of each terminal session. 
The New Environ option under the Twin Client Manager's Settings menu is used to 
create the variables, which are applied to all terminal configurations. Variables can be 
created that apply only to specific terminals (indicated by IP address). It is also possible 
to create variables that apply to all terminals. 
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Creating Common Settings 
Variables that apply to all terminal sessions are created by clicking on the Common to 
all terminals button, and then entering the Variable and Value in the respective boxes. 
Then click on the Set button. 

 

The variable and its value are then displayed in bottom list window.   

Creating Terminal Specific Settings 
Variables that apply to specific terminal sessions are created by clicking on the Terminal 
Specific button, and entering the last two octets of the terminal IP address. Then entering 
the Variable and Value in the respective boxes and click on the Set button. 
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Note: Click on the Show all settings check box to display both terminal specific and 
common variables. 

Changing and Deleting Settings 
Variable names and their values can be modified or deleted by clicking on the variable in 
the list window. Change the variable or value by editing the Variable and/or Value 
boxes, and click on the Set button. To delete the variable, press the Delete key on the 
PC. Deleted variables will continue to appear in the pull down list until after the settings 
have been saved. 

Saving New Environ Settings 
 
Click on the OK button to save the New Environ settings. 

TN3270E Negotiation 
The following defines the TN3270E negotiation, permitting the transfer of some of the 
TN3270E Sub-negotiation variables such as Lunames from the Telnet terminal to the 
host during session initialization. 

Note: This pertains to 3270 emulation. 

TN3270E is implemented on OpenAir Linux using two text files located in the working 
directory (refer to /etc/.CRF/WORKDIR). The tnenvcom.cf file allows for the definition 
of variables that will be shared by all devices, and the tnenv.cf file allows for the 
definition of terminal-specific variables. These files are currently created and maintained 
with the system editor. 
 
Line Entry Format, tnenvcom.cf: 

VARIABLE=VALUE; 

Example *DEVTYP=IBM-3278-2;*CONNECT=RFZ81; 

This will assign all terminals the luname of RFZ81. 
 
Line Entry format, tnenv.cf: 

IDENT:VARIABLE=VALUE;[VARIABLE=VALUE]…! 

Where IDENT is either the last two octets of the terminal's IP address, or the three digit 
Spectrum address (065-511). Multiple variables can be defined, separated by semi-
colons. The entry is terminated with an exclamation. 

Example file: 

#IP terminals fully qualified octets 7 characters: 
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010.031:*DEVTYPE=IBM-3278-2;*CONNECT=RF3278.001;! 

010.032:*DEVTYPE=IBM-3278-2;*CONNECT=RF3278.002;! 

This will assign the terminal with an IP address of xxx.yyy.010.031 a device type of IBM-
3278-2 to the luname of RF3278.001. 

New Environ Negotiation 
The following defines the New Environ negotiation, permitting the transfer of 
environmental variables from the Telnet terminal to the host during session initialization. 

Note: This pertains to the 5250 and VT emulations. 

New Environ is implemented on OpenAir Linux using two text files located in the 
working directory (refer to /etc/.CRF/WORKDIR). The tnenvcom.cf file allows for the 
definition of variables that will be shared by all devices, and the tnenv.cf file allows for 
the definition of terminal-specific variables. These files are currently created and 
maintained with the system editor. 

Line Entry Format, tnenvcom.cf: 

VARIABLE=VALUE; 

Line Entry format, tnenv.cf: 

IDENT:VARIABLE=VALUE;[VARIABLE=VALUE]…! 

Where IDENT is either the last two octets of the terminal's IP address, or the three digit 
Spectrum address (065-511). Multiple variables can be defined, separated by semi-
colons. The entry is terminated with an exclamation. 

Example file: 

#IP terminals fully qualified octets 7 characters: 

010.031:DEVNAME=RF5291.001;! 

#Spectrum ONE fully qualified radio ID 3 characters 

065:DEVNAME=RF5291.002;! 
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Chapter 6 • The Display Formatter 
The display formatter adapts full screen Telnet applications to the portable terminal 
environment without any modification to the host application. This powerful tool is an 
optional feature, used with the OpenAir server when the Twin Client is operating in the 
Server mode. 

A screen capture utility (included with the Twin Client Manager) is used to access the 
host application via Telnet and "capture" the host displays. Once captured, the screens 
are processed into a screen formatter object and assigned to a terminal configuration, 
which can then be downloaded automatically to the terminal, over the wireless network. 

The Twin Client Display Formatter provides the following unique features: 
• = Performance – Optimized for minimum run-time overhead and maximum speed. 
• = Transparency – Fully transparent to the host application. 
• = Capacity – Up to 128 host screens per object, 16 terminal screens per host screen, 

and 32 input fields per terminal screen. 
• = Simplicity – Intuitive drag-and-drop interface for screen capture and formatting. 
• = Flexibility – Supports all Twin Client terminals. 

This chapter describes how to set the emulation, capture the host application displays, 
and process them into formatter objects for download to the terminal. 

Setting the Emulation 
The first step in the formatting process is to set the emulation (VT/HP, 3270, or 5250) in 
preparation for capturing the host application displays. Click on Start, Programs, 
PowerNet, Twin Client Manager, and then on the Settings menu, as shown below. 

 

Click on Emulation and select an emulator from the list below. 
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Then click on OK to return to the main Twin Client menu. 

 

Starting the Emulator 
Start the emulator by clicking on the Object Editors menu and Screen Capture, as 
shown below. 

 

The emulation window is displayed. Click on the Session menu, and then click on 
Session Settings. 

 

In the Session Settings menu, enter the Host IP address and port of the host system, and 
then Click on OK to return to the emulator main menu. 
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Note: The Host Port of 23 is standard for Telnet. However, for security reasons the port 
number may be set to other values. Consult the local network administrator if a 
connection cannot be established on port 23. 

 

To start a Telnet session with the host, click on the  toolbar icon, or click on the 
Session menu and then on Connect. In this example, the 5250 emulator is used and the 
host system is an IBM AS/400. 

 
The host application displays are now ready to be captured. 
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Taking Snapshots 
The host screens are captured by clicking on the  toolbar icon while the desired 
screen is displayed. Alternately, click on Session and then Snapshot. The following 
pop-up indicates that the screen was captured. 

 

Click on OK and continue to navigate the host application, taking snapshots of the 
screens to be formatted. 

Saving the Screen File 

Save the snapshots at any time by clicking on the  toolbar icon. Alternately, click on 
File and then Save As. The following window is displayed for entering the filename. 

 

For this example, the filename is set to app1. Then click on the Save button to return to 
the emulator.  

Exiting the Emulator 

The Telnet session is ended by clicking on the  toolbar icon, or by clicking on 
Session and Disconnect. Return to the Twin Client Manager window to format the 
screens by clicking on the  icon at the top right corner of the emulator, or by clicking 
on File and Exit. 
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Formatting 
The screen file created in the previous sections can now be formatted. This section 
describes how to start the formatter, open a screen file, format the screens, save the 
formatted object, and finally to assign it to a configuration. 

Starting the Formatter 
The formatter is started from the Twin Client Manager menu. Start the Twin Client 
Manager by clicking on, Start, Programs, PowerNet, and Twin Client Manager. Then 
click on Object Editors, as shown below. 

 

Click on the Display/Formatting option and the formatter window is displayed. To open 
the screen file, click on File. 

 

Then click on Open, and click on the screen filename. 
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Then click on the Open button and the formatter window is displayed, including the first 
host display that was captured. The terminal display window, which is blank at this time 
since no formatting has taken place, is also shown. 

Note: The Terminal display window floats on top of the host screen. If it needs to be 
moved, click on the title bar and drag it to a different area of the host screen. 

 

Setting Up the Formatter 
The terminal display must be set to match the terminal for which the formatter object is 
to be created. Click on the Tools menu and then Setup.  
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Click on the desired terminal display size, and also ensure that the host screen size is set 
correctly. Then click on OK to return to the formatter. 

Copying an Input Field 
An input field is copied from the host display to the terminal display by the same method 
used to copy text. Click the left side of the input field and drag the cursor to the right. 
The input field will be highlighted. Now click on the field again and drag it to the desired 
position in the Terminal display. 

Adding an Input Field 
To add an input field, create text in the screen formatter window, highlight it, and chose 
Add Input Field from the Host menu. The input filed added in the example below is a 
lower-case letter “x”. 



Keyboard Mapping 

6-8  PowerNet Twin Client Configuration   •    September, 2003 

 

Adding and Copying Variable Display Text 
Variable text can be added to the terminal display by clicking on the Terminal window, 
moving the cursor to the desired display position, and typing in the text (in this case, 
variable text) as shown below. 

To do this, move the cursor to the desired position in the host display and hold down the 
mouse button while moving the cursor to the right. Then, right-click on the text to be 
copied. This text will be highlighted as shown by the words “variable text” copied 
below. Then drag the highlighted text to the desired position in the terminal display and 
release the mouse button. 
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Deleting a Field 
Select the text to be deleted by highlighting it, and choose Delete Field from the Host 
menu. 

 

Finding a Field on the Terminal 
To find a field on the terminal, and choose Find Field on Terminal from the Host menu. 
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Adding an Ident 
Formatting requires each host screen to be uniquely identified. One way to do this is to 
highlight unique text on the host screen (click on the left side of the text and drag the 
mouse to the right). Then click on the right mouse button, as show below. 

 
 
From the pull down menu, click on Add Ident. The highlighted field is now colored red 
on the host display, indicating that it is an Ident field. Up to 32 items can be highlighted 
on each host screen, so if a number of screens share similar features, they can be 
uniquely identified by adding more Idents. In the event that a group of host displays 
differ only by position of input fields, input fields can be used for Idents also. 

Removing an Ident 
Remove an Ident field by highlighting it, and then selecting Remove Ident from the 
Host menu. 
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Navigating the Screen Formatter 
To move to the first screen in the screen formatter, choose First Screen from the Host 
menu. 

 

To move to the next screen, select Next Screen from the Host menu. 
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To move to the previous screen, select Previous Screen from the Host menu. 

 

To move to the last screen, select Last Screen from the Host menu. 
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Adding a Terminal Screen 
New terminal screens are created by using the New button at the bottom of the Terminal 
display window. This is useful when more that one terminal screen is required to format 
the relevant data on the host screen. Up to 16 terminal displays can be associated with 
each formatted host display. These are called terminal pages, and the page that is 
displayed on the terminal at any point in time depends on the location of the host cursor 
position. The page to which the corresponding input field is formatted is the one 
displayed. 

 

When multiple pages are present, the directional arrows are used to navigate through the 
pages. 

Deleting a Screen 
To delete a screen, select Delete Screen from the Host menu. 
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Saving the Formatter Object 
The formatter object is saved by clicking on the  toolbar icon, or by clicking on File 
and Save.  

Assigning the Object to a Terminal Configuration 
The formatter object is assigned to a terminal configuration by opening a terminal 
configuration in the Twin Client Manager, assigning the object to the Display Formatting 
Object, and saving the configuration.  

To open a terminal configuration, click on File in the Twin Client Manager, as shown 
below. 

 

Then click on Open, and click on the desired terminal configuration. 
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Then click on the advanced view Display tab, pull down the Display Formatter Object 
scrolling list box, and click on the object. 

 

Save the newly modified terminal configuration using the  toolbar icon, or click on 
File and then Save. The new configuration, incorporating the formatter object, is 
updated on the terminal, automatically, by cold booting the terminal. 
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Chapter 7 • TN Plus Features 
 

The following features belong to Release 7.0. These features, like the Formatter feature, 
are also optional as add-ons. 
 
Under Tools in Twin Client Manager are the Screen Watcher, Terminal Messenger, and 
RF Monitor features. 
 
Note: The terminal may or may not be able to utilize the Screen Watcher or Terminal 

Messenger features depending on its authorization codes. 
 

 
 

Select Screen Watcher, enter the terminal’s IP address, and click on OK. 
 

 
 

A screen will appear with a display resembling the terminal screen. 
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Clicking on the Font button on the upper left brings up a screen in which you can modify 
the font settings, as shown below. 
 

 
 
Select Terminal Messenger from the Tools menu.  
 
You may enter an Address Range in the From and To boxes on this screen. Click on Add 
when finished. 
 
Enter a message to send in the space provided, select the terminal to receive this message 
by clicking on it in the Select Terminal(s) column, and click on the Send button to send 
the message of your choice to the terminal of your choice. 
 
See the example of the Terminal Messenger screen below. 
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To remove a terminal from the list of terminals receiving your message, click on the 
terminal number in the Select Terminal(s) column, and click on the Remove button. 
Click on the appropriate button, Remove All, Select All, or Unselect All, to remove all 
terminals, select all terminals, or unselect all terminals from the Select Terminal(s) list. 
 
Note: Use the Ctrl and Shift keys to select multiple terminals. 
 
Click on the Close button when finished. 
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Select RF Monitor from the Tools menu. 
 

 
 

Click on File to Select Terminal or to Exit. 

 

Choosing Select Terminal allows you to view a log of the terminal’s activity. Enter the 
Terminal IP address and Terminal IP Port, and click on OK.  

 

Click on Edit. Select Find, and/or Find Next to search for pieces of information in your 
log, or select Clear to clear the search. 
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Click on Actions to Start the Monitor or Stop the Monitor. 

 

Click on Tools to set Debug Levels or Settings. 

 

The options in Debug Levels are shown below. 

 

The maximum log file size can be set under Settings. 
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Click on View to show or hide the Toolbar and the Status Bar.  

 

This is the Toolbar. It is found near the top of the screen. 

 

This is the Status Bar. It is found at the bottom of the screen. 

 

Click on Help to bring up the following screen. 

 

From the Tools menu, select Server Transfer. 

 
The FTP Settings screen appears. 
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To send object editor and configuration files from Windows to your Linux box, enter 
your server address, and click on OK. 
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Chapter 8 • Printer Support 

Introduction 
This chapter describes printing in each of the emulation modes, with an example of 
printing using VTerm in VT-220 emulation mode. 

Printing under IBM 3270 & 5250 Emulation 
General 
The appearance of a Flag Byte at a specific Flag Row and Flag Column position in the 
screen causes the handler on the NCU to take all characters after the flag byte, up to the 
next appearance of the flag byte, and send them to the printer on the terminal. 

After the printer data has been sent, the handler sends the specified Response Key to the 
host application. At this point, the host application must clear the printer data from the 
3270 screen, or replace it with the next set of printer data. 

For the purpose of initializing a printer and for testing print data, an Init File text file can 
be placed on the NCU in the /crf directory.  The contents of this file will be transmitted 
to the terminal when the RF terminal attaches to the IBM handler on the NCU. 

IBM Handler Configuration 
1. Refer to the “Printer” section on Page 1 of the 3270 and 5250 Handler setup screen. 

2. Set the printer type as appropriate. 

3. Set the decimal value of the ASCII-converted “Flag Byte” to be used by the host 
application. 

4. Set the zero-based row and column for the Flag Byte. For example, a host 3270 
application set for row 1, column 1 is Flag Row 0, Flag Column 0 within the handler 
setup. 

5. Set the Response Key that signals the application to either remove or replace the 
print data from the screen. 

6. In the event the printer requires initialization data and/or the actual print data must 
be tested for validity, enter the name of the file in the Init File field. 
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Printing under VTERM VT100/220 Emulation 
To output data to the RS-232 port on the terminal under VT100/220 emulation, your 
application must call the Media Copy (MC) feature of the VT-220 device. This uses the 
following escape sequence: 

ESC [5i All data following this escape sequence will be output to the terminal RS232 
port until the escape sequence ESC [4i is reached. 

VTerm Handler Configuration 
1. Refer to the “Printer” section on Page 1 of the VTerm Handler setup screen. 

2. Set the printer type as appropriate. 

3. In the event the printer requires initialization data, and/or the actual print data must 
be tested for validity, enter the name of the file in the “Init File” field. 

Example of printing under VTerm/VT220 Emulation 

The following is an example taken from several traces of a print sequence on a 
VTerm/TIP system. 

Here is the rfvt log. Note that the label print operation is started by the command ESC[5i. 
 
11/13 07:14:37 0ms RCV AP DATA: 240 bytes (240 total)
08 1B 5B 4B 20 20 1B 5B 35 69 0A 4E 0A 44 36 0A ..[K...
[5i.N.D6. (Print start cmd is ‘ESC[5i’)
53 31 0A 5A 54 0A 41 37 35 30 2C 31 31 35 30 2C S1.ZT.A750,1150,
32 2C 34 2C 31 2C 31 2C 4E 2C 22 45 6C 69 64 61 2,4,1,1,N,"Elida
20 47 69 62 62 73 20 55 6E 69 6C 65 76 65 72 20 .Gibbs.Unilever.
49 54 22 0A 41 31 37 30 2C 31 31 35 30 2C 32 2C IT".A170,1150,2,
32 2C 32 2C 32 2C 4E 2C 22 49 4E 54 45 52 49 22 2,2,2,N,"INTERI"
0A 41 35 32 30 2C 31 31 30 30 2C 32 2C 33 2C 32 .A520,1100,2,3,2
2C 32 2C 4E 2C 22 45 53 50 52 45 53 53 22 0A 41 ,2,N,"ESPRESS".A
35 38 30 2C 31 30 33 30 2C 32 2C 35 2C 36 2C 36 580,1030,2,5,6,6
2C 4E 2C 22 43 5A 22 0A 41 37 35 30 2C 36 35 30 ,N,"CZ".A750,650
2C 32 2C 32 2C 31 2C 31 2C 4E 2C 22 44 61 74 61 ,2,2,1,1,N,"Data
20 46 61 74 74 2E 3A 22 0A 41 36 30 30 2C 36 35 .Fatt.:".A600,65
30 2C 32 2C 33 2C 31 2C 31 2C 4E 2C 22 31 30 2D 0,2,3,1,1,N,"10-
30 33 2D 39 35 22 0A 41 34 35 30 2C 36 35 30 2C 03-95".A450,650,
32 2C 32 2C 31 2C 31 2C 4E 2C 22 4E 75 6D 2E 41 2,2,1,1,N,"Num.A
11/13 07:14:38 100ms poll: 1 events PTY=00000001 SMI=00000000
11/13 07:14:38 0ms RCV AP DATA: 572 bytes (812 total)
(Start of second host block)
6C 6C 65 73 74 2E 3A 22 0A 41 33 30 30 2C 36 35 llest.:".A300,65
30 2C 32 2C 33 2C 31 2C 31 2C 4E 2C 22 20 31 30 0,2,3,1,1,N,".10
30 39 35 22 0A 41 31 38 30 2C 36 35 30 2C 32 2C 095".A180,650,2,
32 2C 31 2C 31 2C 4E 2C 22 56 69 61 67 2E 3A 22 2,1,1,N,"Viag.:"
0A 41 38 30 2C 36 35 30 2C 32 2C 33 2C 31 2C 31 .A80,650,2,3,1,1
2C 4E 2C 22 30 31 22 0A 41 37 35 30 2C 36 30 30 ,N,"01".A750,600
2C 32 2C 31 2C 31 2C 31 2C 4E 2C 22 20 20 41 72 ,2,1,1,1,N,"..Ar
74 69 63 6F 6C 6F 20 20 20 20 20 20 20 20 20 20 ticolo..........
20 43 6F 6C 6C 69 2F 50 7A 20 20 20 20 20 20 20 .Colli/Pz.......
20 20 50 65 73 6F 20 28 4B 67 29 20 22 0A 41 37 ..Peso.(Kg).".A7
34 30 2C 35 37 30 2C 32 2C 33 2C 31 2C 31 2C 4E 40,570,2,3,1,1,N
2C 22 31 31 32 32 38 30 30 34 34 20 20 20 20 20 ,"112280044.....
20 20 20 31 34 34 20 20 20 20 20 20 20 31 32 30 ...144.......120
2C 33 22 0A 41 37 35 30 2C 35 30 30 2C 32 2C 32 ,3".A750,500,2,2
2C 31 2C 31 2C 4E 2C 22 54 69 70 6F 20 50 61 6C ,1,1,N,"Tipo.Pal
6C 65 74 2E 3A 22 0A 41 35 37 30 2C 35 30 30 2C let.:".A570,500,
32 2C 33 2C 31 2C 31 2C 4E 2C 22 45 55 52 22 0A 2,3,1,1,N,"EUR".
41 34 35 30 2C 35 30 30 2C 32 2C 32 2C 31 2C 31 A450,500,2,2,1,1
2C 4E 2C 22 50 65 73 6F 28 4B 67 29 3A 22 0A 41 ,N,"Peso(Kg):".A
33 35 30 2C 35 30 30 2C 32 2C 33 2C 31 2C 31 2C 350,500,2,3,1,1,
4E 2C 22 20 20 32 35 2C 30 22 0A 41 34 35 30 2C N,"..25,0".A450,
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34 35 30 2C 32 2C 32 2C 31 2C 31 2C 4E 2C 22 54 450,2,2,1,1,N,"T
6F 74 2E 20 50 65 73 6F 28 4B 67 29 3A 22 0A 41 ot..Peso(Kg):".A
32 35 30 2C 34 35 30 2C 32 2C 33 2C 31 2C 31 2C 250,450,2,3,1,1,
4E 2C 22 20 31 34 35 2C 33 22 0A 42 37 35 30 2C N,".145,3".B750,
33 30 30 2C 32 2C 31 2C 34 2C 31 32 2C 31 35 30 300,2,1,4,12,150
2C 42 2C 22 36 30 30 30 30 33 34 4E 4F 52 36 35 ,B,"6000034NOR65
34 33 32 31 36 31 22 0A 50 0A 1B 5B 34 69 0A 20 432161".P..[4i..
(End Print cmd is ‘ESC[4i’)
20 20 20 20 20 20 20 20 20 20 20 20 20 20 20 20 ................
20 20 1B 5B 48 1B 5B 4A 20 48 55 49 1B 5B 35 43 ...[H.[J.HUI.[5C
54 45 53 54 20 53 54 41 4D 50 41 20 45 54 49 43 TEST.STAMPA.ETIC
48 45 54 54 20 20 31 33 2F 31 31 2F 39 36 1B 5B HETT..13/11/96.[
33 3B 39 48 54 45 53 54 20 53 54 41 4D 50 41 20 3;9HTEST.STAMPA.
45 54 49 43 48 45 54 54 45 1B 5B 38 3B 31 31 48 ETICHETTE.[8;11H
46 31 20 41 6E 6E 75 6C 6C 61 20 46 32 20 43 6F F1.Annulla.F2.Co
6E 66 65 72 6D 61 20 5F 1B 5B 4A 08 nferma._.[J.
11/13 07:14:38 280ms prt_out_unseg: 672 bytes in
11/13 07:14:38 0ms prt_out_unseg: 254 bytes out
11/13 07:14:38 0ms RF SND 256 bytes
44 FE 0A 4E 0A 44 36 0A 53 31 0A 5A 54 0A 41 37 D..N.D6.S1.ZT.A7
(1st TIP cmd D with length FE [254 chars])
35 30 2C 31 31 35 30 2C 32 2C 34 2C 31 2C 31 2C 50,1150,2,4,1,1,
4E 2C 22 45 6C 69 64 61 20 47 69 62 62 73 20 55 N,"Elida.Gibbs.U
6E 69 6C 65 76 65 72 20 49 54 22 0A 41 31 37 30 nilever.IT".A170
2C 31 31 35 30 2C 32 2C 32 2C 32 2C 32 2C 4E 2C ,1150,2,2,2,2,N,
22 49 4E 54 45 52 49 22 0A 41 35 32 30 2C 31 31 "INTERI".A520,11
30 30 2C 32 2C 33 2C 32 2C 32 2C 4E 2C 22 45 53 00,2,3,2,2,N,"ES
50 52 45 53 53 22 0A 41 35 38 30 2C 31 30 33 30 PRESS".A580,1030
2C 32 2C 35 2C 36 2C 36 2C 4E 2C 22 43 5A 22 0A ,2,5,6,6,N,"CZ".
41 37 35 30 2C 36 35 30 2C 32 2C 32 2C 31 2C 31 A750,650,2,2,1,1
2C 4E 2C 22 44 61 74 61 20 46 61 74 74 2E 3A 22 ,N,"Data.Fatt.:"
0A 41 36 30 30 2C 36 35 30 2C 32 2C 33 2C 31 2C .A600,650,2,3,1,
31 2C 4E 2C 22 31 30 2D 30 33 2D 39 35 22 0A 41 1,N,"10-03-95".A
34 35 30 2C 36 35 30 2C 32 2C 32 2C 31 2C 31 2C 450,650,2,2,1,1,
4E 2C 22 4E 75 6D 2E 41 6C 6C 65 73 74 2E 3A 22 N,"Num.Allest.:"
0A 41 33 30 30 2C 36 35 30 2C 32 2C 33 2C 31 2C .A300,650,2,3,1,
11/13 07:14:39 1460ms RCV CM_RDY
11/13 07:14:39 0ms prt_out_unseg: 254 bytes out
11/13 07:14:39 10ms RF SND 256 bytes
44 FE 31 2C 4E 2C 22 20 31 30 30 39 35 22 0A 41 D.1,N,".10095".A
(2nd TIP cmd D with length FE [254 chars])
31 38 30 2C 36 35 30 2C 32 2C 32 2C 31 2C 31 2C 180,650,2,2,1,1,
4E 2C 22 56 69 61 67 2E 3A 22 0A 41 38 30 2C 36 N,"Viag.:".A80,6
35 30 2C 32 2C 33 2C 31 2C 31 2C 4E 2C 22 30 31 50,2,3,1,1,N,"01
22 0A 41 37 35 30 2C 36 30 30 2C 32 2C 31 2C 31 ".A750,600,2,1,1
2C 31 2C 4E 2C 22 20 20 41 72 74 69 63 6F 6C 6F ,1,N,"..Articolo
20 20 20 20 20 20 20 20 20 20 20 43 6F 6C 6C 69 ...........Colli
2F 50 7A 20 20 20 20 20 20 20 20 20 50 65 73 6F /Pz.........Peso
20 28 4B 67 29 20 22 0A 41 37 34 30 2C 35 37 30 .(Kg).".A740,570
2C 32 2C 33 2C 31 2C 31 2C 4E 2C 22 31 31 32 32 ,2,3,1,1,N,"1122
38 30 30 34 34 20 20 20 20 20 20 20 20 31 34 34 80044........144
20 20 20 20 20 20 20 31 32 30 2C 33 22 0A 41 37 .......120,3".A7
35 30 2C 35 30 30 2C 32 2C 32 2C 31 2C 31 2C 4E 50,500,2,2,1,1,N
2C 22 54 69 70 6F 20 50 61 6C 6C 65 74 2E 3A 22 ,"Tipo.Pallet.:"
0A 41 35 37 30 2C 35 30 30 2C 32 2C 33 2C 31 2C .A570,500,2,3,1,
31 2C 4E 2C 22 45 55 52 22 0A 41 34 35 30 2C 35 1,N,"EUR".A450,5
11/13 07:14:41 1370ms RCV CM_RDY
11/13 07:14:41 0ms prt_out_unseg: 164 bytes out
11/13 07:14:41 0ms RF SND 166 bytes
44 A4 30 30 2C 32 2C 32 2C 31 2C 31 2C 4E 2C 22 D.00,2,2,1,1,N,"
(3rd TIP cmd D with length A4 [164 chars])
50 65 73 6F 28 4B 67 29 3A 22 0A 41 33 35 30 2C Peso(Kg):".A350,
35 30 30 2C 32 2C 33 2C 31 2C 31 2C 4E 2C 22 20 500,2,3,1,1,N,".
20 32 35 2C 30 22 0A 41 34 35 30 2C 34 35 30 2C .25,0".A450,450,
32 2C 32 2C 31 2C 31 2C 4E 2C 22 54 6F 74 2E 20 2,2,1,1,N,"Tot..
50 65 73 6F 28 4B 67 29 3A 22 0A 41 32 35 30 2C Peso(Kg):".A250,
34 35 30 2C 32 2C 33 2C 31 2C 31 2C 4E 2C 22 20 450,2,3,1,1,N,".
31 34 35 2C 33 22 0A 42 37 35 30 2C 33 30 30 2C 145,3".B750,300,
32 2C 31 2C 34 2C 31 32 2C 31 35 30 2C 42 2C 22 2,1,4,12,150,B,"
36 30 30 30 30 33 34 4E 4F 52 36 35 34 33 32 31 6000034NOR654321
36 31 22 0A 50 0A 61".P.
11/13 07:14:42 1050ms RCV CM_RDY
11/13 07:14:42 0ms RF SND 2 bytes
44 00 D.
(TIP cmd to dump data out of serial port)
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11/13 07:14:42 310ms RCV CM_RDY
11/13 07:14:42 0ms prt_out_unseg: all segments complete

All of this processed host data is sent off to the base program to format up and send off 
to the terminal. 

Some excerpts follow of the base log that shows this: 
11/14 09:49:36 120ms app-105 --> 256 - - Data
11/14 09:49:36 0ms r00-105 *** CHK_UNITDTA: thed=0 tsz=256 fhed=0 fsz=0
11/14 09:49:36 0ms bld_dta: 0-105 S=23 N=7 A=4
11/14 09:49:36 0ms bld_dta: 0-105 S=23 N=0 A=4
11/14 09:49:36 0ms r00-105 *** Building DFP DSZ=2

FRAME: Mode BASE 09:49:36 <-- 33 bytes
Frame ID: Data-BOC

S T U N A ST Topology
Hdr: 1B 1 0105 7 4 00 U=0001 Downstream
H: 3B 81 69 9C
D: 44 FE 0A 4E 0A 44 36 0A 53 31 0A 5A 54 0A 41 37 D..N.D6.S1.ZT.A7
(1st TIP cmd D with length FE [254 chars])

D: 35 30 2C 31 31 35 30 50,1150
C: 20 B2 83 70 (in=7083B220,calc=7083B220)

FRAME: Mode BASE 09:49:36 <-- 33 bytes
Frame ID: Data-BOC

S T U N A ST Topology
Hdr: 1B 1 0105 0 4 00 U=0001 Downstream
H: 3B 81 69 80
D: 2C 32 2C 34 2C 31 2C 31 2C 4E 2C 22 45 6C 69 64 ,2,4,1,1,N,"Elid
D: 61 20 47 69 62 62 73 a.Gibbs
C: BF 48 4B 2C (in=2C4B48BF,calc=2C4B48BF)

Each of these messages is ACK’d by the terminal, building up the print string in the 
terminal’s print buffer, and on receipt of the D0 message the print string is sent out of the 
RS-232 port. 
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